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Introduction

Using either the xPC Target™ API dynamic link library (DLL) or the xPC
Target component object model (COM) API library, you can create custom
applications to control a real-time application running on the target PC. You
generate real-time applications from Simulink® models.

o “xPC Target API versus xPC Target COM API” on page 1-2

¢ “What Is xPC Target API?” on page 1-4

¢ “What Is xPC Target COM API?” on page 1-6

¢ “Required Products” on page 1-8



xPC Target API versus xPC Target COM API

The xPC Target API and xPC Target COM API interfaces provide the same
functionality for you to write custom applications. There is no difference in
performance or functionality between applications written against either

library. Note that the C API is threadsafe. The COM API is not threadsafe.

The xPC Target API DLL consists of C functions that you can incorporate into
any high-level language application. The xPC Target COM API consists of

a suite of interfaces that you can reference while building a graphic user
interface (GUI) application. You can incorporate these interfaces using
programming environments that work with COM objects. A user can use an
application written through either interface to load, run, and monitor an xPC
Target application without interacting with MATLAB®. With the xPC Target
API, you write the application in a high-level language (such as C, C++, or
Java) that works with an xPC Target application; this option requires that
you are an experienced programmer. With xPC Target COM API, you use a
graphical development environment to create a GUI that works with an xPC
Target application. Designed to work with Microsoft® COM, the xPC Target
COM API conforms to the component object model standard established by
Microsoft.

The xPC Target API is distributed with two dynamic link libraries (DLLs)
that make it easier to integrate with various development tools, tailoring the
development environment to your needs:

e A function library (xpcapi.dll)

® A component library (xpcapicom.dll)
The following sections describe each library:

¢ “What Is xPC Target API?” on page 1-4
¢ “What Is xPC Target COM API?” on page 1-6



xPC Target™ API versus xPC Target™ COM API

Note In this book, second-person references apply to those who write the
xPC Target API and COM API applications. For example, “You can assign
multiple labels to one tag.” Third-person references apply to those who run
the xPC Target API and COM API applications. For example, “You can later
distribute this executable to users, who can then use the GUI application to
work with target applications.”
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What Is xPC Target API?

The xPC Target API consists of a series of C functions that you can call from a
C or C++ application. These functions enable you to

¢ Establish communication between the host PC and the target PC via an
Ethernet or serial connection

¢ Load the target application, a .d1m file, to the target PC

¢ Run that application on the target PC

® Monitor the behavior of the target application on the target PC
® Stop that application on the target PC

¢ Unload the target application from the target PC

¢ (Close the connection to the target PC

The xpcapi.dll file contains the xPC Target API dynamic link library. It
contains over 90 functions that enable run-time linking rather than static
linking at compile time. The functions provide all the information and
accessibility needed to access the target application. Accessing the xPC Target
API DLL is beneficial when you are building applications using development
environments such as Microsoft Foundation Class Library/Active Template
Library (MFC/ATL), DLL, Win32 (non-MFS) program and DLL, and console
programs integrating with third-party product APIs (for example, Altia).

All custom xPC Target API applications must link with the xpcapi.dll
file (xPC API DLL). Also associated with the dynamic link library is the
xpcinitfree.c file. This file contains functions that load and unload the
xPC Target APIL. You must build this file along with the custom xPC Target
API application.

The documentation reflects the fact that the API is written in the C
programming language. However, the API functions are usable from other
languages and applications, such as C++ and Java.
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Note To write a non-C application that calls functions in the xPC Target API
library, refer to the compiler documentation for a description of how to access
functions from a library DLL. You must follow these directions to access the
xPC Target API DLL.

The following chapters describe the xPC Target API in more detail:

e Chapter 2, “xPC Target API” describes how to create a C xPC Target API
application.

® Chapter 5, “API Function and Method Reference” and Chapter 6, “API
Functions and Methods” describe the xPC Target C and COM API functions.

1-5
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What Is xPC Target COM API?

The xPC Target COM API is an open environment application program
interface designed to work with Microsoft COM and the xPC Target API. The
xPC Target COM API provides the same functionality as the xPC Target API.
It is a programming layer that sits between you and the xPC Target API.
The difference is that while the xPC Target API is a dynamic link library of
C functions, the xPC Target COM API dynamic link library is an organized
collection of objects, classes, and functions. You access this collection through
a graphical development environment such as Microsoft Visual Basic. Using
such a graphical development environment, you can create a custom GUI
application that can work with one xPC Target application. While the xPC
Target API requires you to be an accomplished C or C++ programmer, the
xPC Target COM API makes no such demand.

The xPC Target COM API library depends on xpcapi.dll, the xPC Target
dynamic link library. However, the xPC Target API is independent of the
xPC Target COM APL.

The xPC Target COM API has the following features:

¢ A DLL component server library — xpcapicom.dll is a component server
DLL library COM interface consisting of component interfaces that access
the target PC. The COM API library enhances the built-in functionality of
a programming language by allowing you to easily access the xPC Target
API for rapid development of xPC Target GUI.

¢ Built on top of the xPC Target API — Via an application such as Visual
Basic, xpcapicom.d1ll, using a structured object model hierarchy, provides
full access to all the data and methods needed to interface with an xPC
Target application. It also enables search functionality and bidirectional
browsing capabilities. Generally, you view object models by selecting a type
and viewing its members. Using the xPC Target COM API library, you can
select a member and view the types to which it belongs.

¢ Programming language independent — This section describes how to create
an xPC Target COM API application using Visual Basic. However, the xPC
Target COM API interface is not limited to this third-party product. You
can add the COM API library to any development environment that can
access COM libraries, such as Visual C++ or Java, as well as scripting
languages such as Perl, Python, and Basic.
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¢ Ideal for use with Visual Basic — The xPC Target COM API works well
with Visual Basic, and extends the event-driven programming environment
of Visual Basic.

See Chapter 3, “xPC Target COM API” for a description of how to use the
xPC Target COM API library.

1-7
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Required Products

Refer to “Required Products” in the xPC Target Getting Started Guide for a
list of the required xPC Target products. In addition, you need the following
products:

¢ Third-Party Compiler — Use a third-party compiler to build a custom

application that calls functions from the xPC API library. Although the
xPC API library is written in C, you can write the application that calls
these functions in another high-level language, such as C++. You can use
any compiler that can generate code for Win32 systems.

To write a non-C application that calls functions in the xPC Target API
library, refer to the compiler documentation for a description of how to
access functions from a library DLL. You must follow these directions to
access the xPC Target API DLL.

Third-Party Graphical Development Environment — Use a third-party
graphical development environment to build a custom application that
references interfaces in the xPC COM API library. Layered on top of the
xPC API library, the xPC COM API library enables you to write custom
applications using a component object model library. You can use any
compiler that can work with component object model (COM) objects.
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e “Before You Start” on page 2-2
* “Visual C Example” on page 2-5
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Before You Start

In this section...

“Introduction” on page 2-2

“Important Guidelines” on page 2-2

Introduction

This chapter describes how to write a custom application using the xPC
Target API. This API enables you to write high-level language applications to
load an xPC Target application, and run and control it.

Before you start, read this section for important notes on writing custom
applications based on the xPC Target API. It is assumed that you already
know how to write C or C++ code.

This chapter provides tutorials on how to generate a C application for xPC
Target. It also provides some guidelines on using the xPC Target API. Refer
to “Visual C Example” on page 2-5 for tutorials that you can follow to create,
build, and run a sample Visual C program.

For the xPC Target API function synopses and descriptions, refer to “API
Function and Method Reference”.

Important Guidelines

This section describes some guidelines you should keep in mind before
beginning to write xPC Target API applications with the xPC Target API DLL:

® You must carefully match the data types of the functions documented in
the API function reference. For C, the API includes a header file that
matches the data types.

¢ To write a non-C application that calls functions in the xPC Target API
library, refer to the compiler documentation for a description of how to
access functions from a library DLL. You must follow these directions to
access the xPC Target API DLL
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¢ [If you want to rebuild the model sf_car_xpc.mdl, or otherwise use
MATLAB, you must have xPC Target Version 2.0 or later. This is the
version of xPC Target that comes with Release 13 (MATLAB 6.5) or later.

To determine the version of xPC Target you are currently using, at the
MATLAB command line, type

xpclib

This opens the xPC Target Simulink blocks library. The version of xPC
Target should be at the bottom of the window.

® You can work with xPC Target applications with either MATLAB or an
xPC Target API application. If you are working with an xPC Target
application simultaneously with a MATLAB session interacting with the
target, keep in mind that only one application can access the target PC at
a time. To move from the MATLAB session to your application, in the
MATLAB Command Window, type

close(xpc)

This frees the connection to the target PC for use by your xPC Target API
application. Conversely, you will need to quit your application, or do the
equivalent of calling the function xPCClosePort, to access the target from
a MATLAB session.

¢ All xPC Target API functions that communicate with the target PC check
for time-outs during communication. If a time-out occurs, these functions
will exit with the global variable xPCError set to either ECOMTIMEOUT
(serial connections) or ETCPTIMEOUT (TCP/IP connections). Use the
xPCGetLoadTimeOut and xPCSetLoadTimeOut functions to get and set the
time-out values, respectively.

There are a few things that are not covered in Chapter 5, “API Function and
Method Reference” and Chapter 6, “API Functions and Methods” for the
individual functions, because they are common to almost all the functions in
the xPC Target API. These are

® Almost every function (except xPCOpenSerialPort, xPCOpenTcpIpPort,
xPCGetLastError, and xPCErrorMsg) has as one of its parameters the
integer variable port. This variable is returned by xPCOpenSerialPort
and xPCOpenTcpIpPort, and is the placeholder for the communications link
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with the target PC. The returned value from these two functions should
be used in the other functions to ensure that the proper communications
channel is used.

® Almost every function (except xPCGetLastError and xPCErrorMsg) sets a

global error value in case of error. The application obtains this value by
calling the function xPCGetLastError, and retrieves a descriptive string
about the error by using the function xPCErrorMsg. Although the actual
values of the error numbers are subject to change, a zero value always
means that the operation completed without errors, while a nonzero value
typically signifies an error condition. Note also that the library resets the
error value every time an API function is called; therefore, your application
should check the error status as soon as possible after a function call.

Some functions also use their return values (if applicable) to signify that
an error has occurred. In these cases as well, you can obtain the exact
error with xPCGetLastError.
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Visual C Example

In this section...

“Introduction” on page 2-5

“Directories and Files” on page 2-5

“Building the xPC Target Application” on page 2-7

“Creating a Visual C Application” on page 2-7

“Building a Visual C Application” on page 2-12

“Running a Visual C xPC Target API Application” on page 2-12
“Using the xPC Target API C Application” on page 2-13

“C Code for sf_car_xpc.c” on page 2-19

Introduction

This release includes an example using the xPC Target API to create a Win32
console application written in C. You can use this example as a template to
write your own application.

Before you start, you should have an existing xPC Target application that you
want to load and run on a target PC. The following tutorials use the target
application sf_car_xpc.dlm, built from the Simulink model sf_car_xpc.md1l,
which models an automatic transmission control system. The automatic
transmission control system consists of modules that represent the engine,
transmission, and vehicle, with an additional logic block to control the
transmission ratio. User inputs to the model are in the form of throttle (%)
and brake torque (pound-foot). You can control the target application through
MATLAB with the Simulink External Model interface, or through a custom
xPC Target API application, which you can create using the tutorials in this
chapter.

Directories and Files

This directory contains the C source of a Win32 console application that serves
as an example for using the xPC Target API. The necessary sf_car_xpc files
are in the directory
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C:\matlabroot\toolbox\rtw\targets\xpc\api

Filename Description

VisualBasic\Models\ - Simulink model for use with xPC Target
sf_car_xpc\sf_car_xpc.mdl

VisualBasic\Models)\ - Target application compiled from Simulink
sf_car_xpc\sf_car_xpc.dlm | model

VisualC\sf_car_xpc.dsp Project file for API application
sf_car_xpc.c Source code for API application
VisualC\sf_car_xpc.exe Compiled APT application
VisualBasic\Models)\ - xPC Target API functions for all
xpcapi.dll programming languages. Place this file in

one of the following, in order of preference:

¢ Directory from which the application is
loaded

¢ Windows system directory

The necessary xPC Target API files are in the directory

C:\matlabroot\toolbox\rtw\targets\xpc\api

You will need the files listed below for creating your own API application
with Microsoft Visual C++.

Filename Description

xpcapi.h Mapping of data types between xPC Target API and
Visual C

xpcapiconst.h Symbolic constants for using scope, communication,
and data-logging functions

xpcinitfree.c C functions to upload API from xpcapi.dll

xpcapi.dll xPC Target API functions for all programming
languages
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Building the xPC Target Application

The tutorials in this chapter use the prebuilt xPC Target application

C:\matlabroot\toolbox\rtw\targets\
xpcl\api\VisualC\sf_car_xpc.dlm

You can rebuild this application for your example:
1 Create a new directory under your MathWorks directory. For example,

D:\mwd\sf_car_xpc2

2 Create a Simulink model and save to this directory. For example,

sf_car_xpc2.mdl

3 Build the target application with Real-Time Workshop® and Microsoft
Visual C++. The target application file sf_car_xpc2.d1lm is created.

Using Another C/C++ Compiler

The tutorials in this chapter describe how to create and build C applications
using Microsoft Visual C++. However, to build an xPC Target API C
application, you can use any C/C++ compiler capable of generating a Win32
application. You will need to link and compile the xPC Target API application
along with xpcinitfree.c to generate the executable. The file xpcinitfree.c
contains the definitions for the files in the xPC Target API and is located at

C:\matlabroot\toolbox\rtw\targets\xpc\api

Creating a Visual C Application

This tutorial describes how to create a Visual C application. It is assumed
that you know how to write C applications. Of particular note when writing
xPC Target API applications,

e (Call the function xPCInitAPI at the start of the application to load the
functions.

e (Call the function xPCFreeAPI at the end of the application to free the
memory allocated to the functions.
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To create a C application with a program such as Microsoft Visual C++,

1 From the previous tutorial, change directory to the new directory. This is
your working directory. For example,

D:\mwd\sf_car_xpc2

2 Copy the files xpcapi.h, xpcapi.dll, xpcapiconst.h, and xpcintfree.c
to the working directory. For example,

D:\mwd\sf_car_xpc2

3 Click the Start button, choose the Programs option, and choose the
Microsoft Visual C++ entry. Select the Microsoft Visual C++ option.

The Microsoft Visual C++ application is displayed.
4 From the File menu, click New.

5 At the New dialog, click the File tab.
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Files | Projects | Workspaces Other Documents

.;ﬁ Active Server Page
22 Binary File

4| Bitap File

AL+ Header File
EI:Z'++ Source File
E% Curzar File

[$] HTML Page
m lcon File

I<: tacro File
Resource Script

™| Add to project:

File name:;

Isf_cal_:-:pc.c

Logation:

ID:\mwd\&f_u:ar_:-:pﬂ

Resource Template
SOL Script File
Text File

0K I Cancel |

6 In the left pane, select C++ Source File. In the right, enter the name of
the file. For example, sf_car_xpc.c. Select the directory. For example,
C:\mwd\sf_car_xpc2.

7 Click OK to create this file.

8 Enter your code in this file. For example, you can enter the contents of
sf_xpc_car.c into this file.

9 From the File menu, click New.

10 At the New dialog, click the Projects tab.

2-9
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Filez  Projects L\\g Workspaces Other Documents

e ATL COM Appiwizard Project name:
¢ | Cluster Resource Type “Wizard I&f_u:ar_:-:pu:
g<| Custom Appiafizard

& D atabase Project Logation:
far DevStudio Add-in wizard ID:\mwd\SF_C&FH_XPEE\sf_car J

i 1P Activer, Controb/izard % Create new workspace

@ MFC Appwizard [dl) ) Add b current workspace

8 FC Appiwizard [exe] I | Dependency of:

T4 Utility Praject I j

@Wmﬂ Drwnarnic-Link Librany

% \win32 Static Library s

Iwmz

0K I Cancel

11 In the left pane, select Win32 Console Application. On the right, enter
the name of the project. For example, sf_car_xpc. Select the working
directory from step 1. For example, C:\mwd\sf_car_xpc2.

12 To create the project, click OK.
A Win32 Console Application dialog is displayed.
13 To create an empty project, select An empty project.
14 Click Finish.
15 To confirm the creation of an empty project, click OK at the following dialog.

16 To add the C file you created in step 7, from the Project menu, select the
Add to Project option and select Files.

17 Browse for the C file you created in step 7. For example,
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D:\mwd\sf_car_xpc2\sf_car_xpc.c
Click OK.

18 Browse for the xpcinitfree.c file. For example, D: \mwd\xpcinitfree.c.
Click OK.

Note The code for linking in the functions in xpcapi.dll is in the file
xpcinitfree.c. You must compile and link xpcinitfree.c along with
your custom application for xpcapi.dll to be properly loaded.

19 If you did not copy the files xpcapi.h, xpcapi.dll, and xpcapiconst.h
into the working or project directory, you should either copy them now, or
also add these files to the project.

20 From the File menu, click Save Workspace.

When you are ready to build your C application, go to “Building a Visual
C Application” on page 2-12.

Placing the Target Application File in a Different Directory

The sf_car_xpc.c file assumes that the xPC Target application file
sf_car_xpc.dlmis in the same directory as sf_car_xpc.c. If you move that
target application file (sf_car_xpc.dlm) to a new location, change the path
to this file in the API application (sf_car_xpc.c) and recompile the API
application. The relevant line in sf_car_xpc.c is in the function main(),
and looks like this:

xPCLoadApp(port, ".", "sf_car_xpc"); checkError("LoadApp: ");

The second argument (".") in the call to xPCLoadApp is the path to
sf_car_xpc.dlm. The "." indicates that the files sf_car_xpc.dlm and
sf_car_xpc.c are in the same directory. If you move the target application,
enter its new path and rebuild the xPC Target API application.

2-11



2 xPC Target API

2-12

Building a Visual C Application

This tutorial describes how to build the Visual C application from the previous
tutorial, or to rebuild the example executable sf_car_xpc.exe, with Microsoft
Visual C++:

1 To build your own application using the xPC Target API, ensure that the
files xpcapi.h, xpcapi.dll, xpcapiconst.h, and xpcinitfree.c arein
the working or project directory.

2 If Microsoft Visual C++ is not already running, click the Start button,
choose the Programs option, and choose the Microsoft Visual C++ entry.
Select the Microsoft Visual C++ option.

3 From the File menu, click Open.
The Open dialog is displayed.

4 Use the browser to select the project file for the application you want to
build. For example, sf_car_xpc.dsp.

5 If a corresponding workspace file (for example, sf_car_xpc.dsw) exists for
that project, a dialog prompts you to open that workspace instead. Click
OK.

6 Build the application for the project. From the Build menu, select either
the Build project_name.exe or Rebuild All option.

Microsoft Visual C++ creates a file named project_name.exe, where
project_name is the name of the project.

When you are ready to run your Visual C Application, go to “Running a Visual
C xPC Target API Application” on page 2-12.

Running a Visual C xPC Target APl Application

Before starting the API application sf_car_xpc.exe, ensure the following:

¢ The file xpcapi.dll must either be in the same directory as the xPC Target
API application executable, or it must be in the Windows system directory
(typically C:\windows\system or C:\winnt\system32) for global access.
The xPC Target API application depends on this file, and will not run if the
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file is not found. The same is true for other applications you write using
xPC Target API functions.

® The compiled target application sf_car_xpc.dlm must be in the same
directory as the xPC Target API executable. Do not move this file out of
this directory. Moving the file requires you to change the path to the target
application in the API application and recompile, as described in “Building
a Visual C Application” on page 2-12.

Using the xPC Target API C Application

Any xPC Target API application requires you to have a working target PC
running at least xPC Target Version 2.0 (Release 13).

This tutorial assumes that you are using the xPC Target API application
sf_car_xpc.exe that comes with xPC Target. In turn, sf_car_xpc.exe
expects that the xPC Target application is sf_car_xpc.dlm.

If you are going to run a version of sf_car_xpc.exe that you compiled yourself
using the sf_car_xpc.c code that comes with xPC Target, you can run that
application instead. Ensure that the following files are in the same directory:
e sf _car_xpc.exe, the xPC Target API executable

e sf _car_xpc.dlm, the xPC Target application to be loaded to the target PC
® xpcapi.dll, the xPC Target API dynamic link library

If you copy this file to the Windows system directory, you do not need to
provide this file in the same directory.

How to Run the sf car_xpc Executable

1 Create an xPC Target boot disk with a serial or network communication. If
you use serial communications, set the baud rate to 115200. Otherwise,
create the boot disk as directed in xPC Target Getting Started.

2 Start the target PC with the xPC Target boot disk.

The target PC displays messages like the following in the top rightmost
message area.

2-13



2 xPC Target API

2-14

3

System: Host-Target Interface is RS232 (COM1/2)
or
System: Host-Target Interface is TCP/IP (Ethernet)

If you have downloaded target applications to the target PC through
MATLAB, in the MATLAB window, type

close(xpc)

This command disconnects MATLAB from the target PC and leaves the
target PC ready to connect to another client.

On the host PC, open a DOS window. Change directory to

C:\matlabroot\toolbox\rtw\targets\xpc\api\VisualC

If you are running your own version of sf_car_xpc.exe, change to the
directory that contains the executable and xPC Target application. For
example,

D:\mwd\sf_car_xpc2

From that DOS window, enter the command to start the demo application
on the host PC and download the target application to the target PC.

The syntax for the demo command is
sf_car_xpc {-t IpAddress:IpPort|-c COMport}

If you set up the xPC Target boot disk to use TCP/IP, then give the target
PC’s IP address and IP port as arguments to sf_car_xpc, along with the
option -t. For example, at the DOS prompt, type

sf_car_xpc -t 192.168.0.1:22222

If you set up the xPC Target boot disk to use RS-232, give the serial port
number as a command-line option. Note that indexing of serial ports starts
from O instead of 1. For example, if you are using serial communication
from COM port 1 on the host PC, type

sf_car_xpc -c O
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On the host PC, the demo application displays the following message:

K o o o e e e e e e e e e e e e e e e e e e e e m e e e m m e m e m m e m e m e m m e m e m e m m e m e m— e —— - *
* xPC Target API Demo: sf_car_xpc. *
* *

* Copyright (c) 2000 The MathWorks, Inc. All Rights Reserved. *

* *

Application sf_car_xpc loaded. SampleTime 0.001 StopTime: -1
R Br Th G VehSpeed VehRPM

N 0 00 0.000 1000.000

The relevant line here is the last one, which displays the status of the
application. The headings are as follows:

R The status of the target application: R if running, N if
stopped

Br The brake torque; legal values range from 0 to 4000

Th The throttle as a percentage (0 - 100) of the total

G Gear the vehicle is in (ranges between 1 and 4)

VehSpeed Speed of the vehicle in miles per hour
VehRPM Revolutions per minute of the vehicle engine (0 to 6000)
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From this screen, various keystrokes control the target application. The
following list summarizes these keys:

Key Action

s Start or stop the application, as appropriate.

T Increase the throttle by 1 (does not go above 100).
t Decrease the throttle by 1 (does not go below 0).

B Increase the brake value by 20 (does not go above

4000). Note that a positive value for the brake
automatically sets the throttle value to 0, and a
positive value for the throttle automatically sets the
brake value to 0.

b Decrease the brake value by 20 (does not go below 0).

Q or Ctrl+C Quit the application.

2-16
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The target PC displays the following messages and three scopes.

+} Real-Time xPC Target Spy

=f_car_xpo B lower y—axis limit set to @.008000

SEMB H uppey y-axis limit set to O. 000060

signal & added

tet Humfamples set to 36

Inf 4 trigger level set to ©B.000000
TriggerScope set to 1

8. 881 H lowey y—axis limit set to @.3080080

- upper y-axis limit set to 180.0000008

stopped d : initializing application finished

RT, single

6 Hold down the Shift key and hold down T until the value of Th reaches 100.
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7 Press s to start the application.

»} Real-Time xPC Target Spy -

=f_car_mpc H parameter 18 updated
123MBE : parameter 18 updated
parameter 18 updated
tet parameter 18 uwupdated
Inf 4 parameter 18 wpdated A
i execution started (sample time: @.081008)

8. 601 i execution stopped atr 31.68350808
2.944e-005 minimal TET: @.BB0026 at time 1.406000

maximal TET: @.000040 at time B8.4010008

RT. single

7
4. 0800608

The first scope (SC1) shows the throttle rising to a maximum value of 100
and the vehicle speed gradually increasing. The third scope (SC3) shows
the vehicle RPM. Notice the changes in the vehicle RPM as the gears shift
from first to fourth gear as displayed in the third numerical scope (SC2).

8 When you are done testing the demo application, type Q or Ctrl+C.

The demo application is disconnected from the target PC, so you can
reconnect to MATLAB.
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C Code for sf_car_xpc.c
This section contains the C code for the sf_car_xpc.c application:

/* File: sf_car_xpc.c

* Abstract: Demonstrates the use of the xPC Target C-API in Human-Machine

* interaction. This file generates a Win32 Console application,

* which when invoked loads the sf_car_xpc.dlm compiled application
* on to the xPC Target PC.

*

* To build the executable, use the Visual C/C++ project

* sf_car_xpc.dsp.

*
* Copyright 2000-2004 The MathWorks, Inc.
*/

/* Standard include files */
#include <stdio.h>

#include <stdlib.h>

#include <limits.h>

#include <ctype.h>

#include <conio.h>

#include <windows.h>

/* xPC Target C-API specific includes */
#include "xpcapi.h"
#include "xpcapiconst.h"

#define SERIAL O
#define TCPIP 1

/* max and min are defined by some compilers, so we wrap them in #ifndef's */
#ifndef max

#define max(a, b) (((a) > (b)) ? (a) : (b))

#endif

#ifndef min

#define min(a, b) (((a) < (b)) ? (a) : (b))

#endif

/* Global Variables */
int mode = TCPIP, comPort = 0;
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int
int
char

/* F
doub
void
void
void

void
void
void
void
void
int

/* F

port;
thrPID, brakePID, rpmSID, speedSID, gearSID;
*ipAddress, *ipPort, *pathToApp = NULL;

unction prototypes */

le getParam(int parlIdx);
setParam(int parlIdx, double parValue);
findParam(char *block, char *param, int *id);
findSignal(char *sig, int *id);

Usage(void);

cleanUp(void);

checkError(char *str);
processKeys(void);

parseArgs(int argc, char *argv[]);
str2Int(char *str);

unction: main =====

* Abstract: Main function for the sf_car_xpc demo

int

main(int argc, char *argv[]) {
printf("\n"

"x xPC Target API Demo: sf_car_xpc.

"* Copyright (c) 2000 The MathWorks, Inc. All Rights Reserved.

SUBE

parseArgs(argc, argv);

atexit(cleanup);

/* Initialize the API */

if (XPCINitAPI()) {
fprintf(stderr, "Could not load api\n");
return -1;

if (mode == SERIAL)
port = xPCOpenSerialPort(comPort, 0);
else if (mode == TCPIP)

*/
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port = xPCOpenTcpIpPort(ipAddress, ipPort);

else {
fprintf(stderr, "Invalid communication mode\n");
exit (EXIT_FAILURE);

}

checkError("PortOpen: ");

xPCLoadApp(port, ".", "sf_car_xpc"); checkError("LoadApp: ")

printf("Application sf_car_xpc loaded, SampleTime: %g StopTime: %g\n\n",
xPCGetSampleTime(port), xPCGetStopTime(port));

checkError (NULL) ;

findParam("Throttle", "Value", &thrPID);
findParam("Brake", "Value", &brakePID);
findSignal("Engine/rpm", &rpmSID);
findSignal("Vehicle/mph", &speedSID);
findSignal("shift_logic/p1", &gearSID);

processKeys(); /* Heart of the application */

if (xPCIsAppRunning(port)) {
xPCStopApp(port);
}

return 0;

} /* end main() */

/* Function: processKeys

* Abstract: This function reads and processes the keystrokes typed by the

*

*

user and takes action based on them. This function runs for most
of the program life. */

void processKeys(void) {

int c = 0;
double throttle, brake;

throttle = getParam(thrPID);

brake = getParam(brakePID);

fputs("\nR Br Th G VehSpeed VehRPM \n", stdout);
fputs( "- “--- N L LT L L \n", stdout);
while (1) {

if (_kbhit()) {
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c = _getch();
switch (c) {
case 't':
if (throttle)
setParam(thrPID, --throttle);
break;
case 'T':
if (brake)
setParam(brakePID, (brake = 0));
if (throttle < 100)
setParam(thrPID, ++throttle);
break;
case 'b':
setParam(brakePID, (brake = max(brake - 200,
if (brake)
setParam(thrPID, (throttle
break;

0));

case 'B':
if (throttle)
setParam(thrPID, (throttle = 0));
setParam(brakePID, (brake = min(brake + 200,
break;
case 's':
case 'S':
if (xPCIsAppRunning(port)) {
xPCStopApp(port); checkError(NULL);
} else {
xPCStartApp(port); checkError(NULL);
}
break;
case 'q':
case 'Q':
return;
break;
default:
fputc(7, stderr);
break;
}
} else {
Sleep(50);

0)));

4000)));
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}

printf( "\r%c %4d %3d %1d %10.3f %10.3F",
(XPCIsAppRunning(port) ? 'Y' ‘N'),
(int)brake, (int)throttle,

(int)xPCGetSignal(port, gearSID),
xPCGetSignal(port, speedSID),
xPCGetSignal(port, rpmSID));

}

} /* end processKeys() */

/* Function:

Usage ====
* Abstract: Prints a simple usage message.

void Usage(void) {

*/

fprintf(stdout,
"Usage: sf_car_xpc {-t IPAddress:IpPort|-c num}\n\n"
"E.g.: sf_car_xpc -t 192.168.0.1:22222\n"
"E.g.: sf_car_xpc -c 1\n\n");

return;
} /* end Usage() */

str2int

/* Function:

"123string" is
*/

* Abstract: Converts the supplied string str to an integer. Returns INT_MIN
* if the string is invalid as an integer (e.g.
* invalid) or if the string is empty.
int str2Int(char *str) {
char *tmp;
int tmpInt;
tmpInt = (int)strtol(str, &tmp, 10);
if (*str == '\0' || (*tmp != '"\0')) {

return INT_MIN;
}
return tmpInt;
} /* end str2Int */

/* Function:
* Abstract:
* based on the arguments.

parseArgs

void parseArgs(int argc, char *argv[]) {
if (argc != 3) {
fprintf(stderr,

Parses the command line arguments and sets the state of variables

*/

"Insufficient command line arguments.\n\n");
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Usage();
exit (EXIT_FAILURE);
}
if (strlen(argv[1]) != 2 |
strchr("-/", argv[1][0]) == NULL ||
strchr("tTcC", argv[1][1]) == NULL) {
fprintf(stderr, "Unrecognized Argument %s\n\n", argv[1]);

(
(

Usage();
exit (EXIT_FAILURE);
}
mode = tolower(argv[1][1]) == 'c' ? SERIAL : TCPIP;
if (mode == SERIAL) {
int tmplInt;
if ((tmpInt = str2Int(argv[2])) > INT_MIN) {
comPort = tmpInt;
} else {
fprintf(stderr, "Unrecognized argument %s\n", argv[2]);
Usage();
}
} else {
char *tmp;
ipAddress = argv[2];
if ((tmp = strchr(argv[2], ':')) == NULL) {
/* memory need not be freed as it is allocated only once, will *
* hang around till app ends. */
if ((ipPort = malloc(6 * sizeof(char))) == NULL) {
fprintf(stderr, "Unable to allocate memory");
exit (EXIT_FAILURE);
}
strcpy(ipPort, "22222");
} else {
*tmp = '\0";
ipPort = ++tmp;

}

return;
} /* end parseArgs() */

/* Function: cleanUp ==
* Abstract: Called at program termination to exit in a clean way. */
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void cleanUp(void) {
xPCClosePort(port);
XPCFreeAPI();
return;

} /* end cleanUp() */

/* Function: checkError

* Abstract: Checks for error by calling xPCGetLastError(); if an error is
* found, prints the appropriate error message and exits. */
void checkError(char *str) {
char errMsg[80];
if (xPCGetLastError()) {
if (str != NULL)
fputs(str, stderr);
XPCErrorMsg (xPCGetLastError(), errMsg);
fputs(errMsg, stderr);
exit (EXIT_FAILURE);
}
return;
} /* end checkError() */

/* Function: findParam

* Abstract: Wrapper function around the xPCGetParamIdx() API call. Also
* checks to see if the parameter is not found, and exits in that
* case. */
void findParam(char *block, char *param, int *id) {
int tmp;
tmp = xPCGetParamIdx(port, block, param);
if (xPCGetLastError() || tmp == -1) {
fprintf(stderr, "Param %s/%s not found\n", block, param);
exit (EXIT_FAILURE);
}
*id = tmp;
return;
} /* end findParam() */

/* Function: findSignal
* Abstract: Wrapper function around the xPCGetSignalIdx() API call. Also
* checks to see if the signal is not found, and exits in that

* case. 1
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void findSignal(char *sig, int *id) {
int tmp;
tmp = xPCGetSignalIdx(port, sig);
if (xPCGetLastError() || tmp == -1) {
fprintf(stderr, "Signal %s not found\n", sig);
exit (EXIT_FAILURE);
}
*id = tmp;
return;
} /* end findSignal() */

/* Function: getParam =

* Abstract: Wrapper function around the xPCGetParam() API call. Also checks
* for error, and exits if an error is found.

double getParam(int parIdx) {
double p;
xPCGetParam(port, parIdx, &p);
checkError("GetParam: ");
return p;

} /* end getParam() */

*/

/* Function: setParam =

* Abstract: Wrapper function around the xPCSetParam() API call. Also checks
* for error, and exits if an error is found.

void setParam(int parIdx, double parValue) {
xPCSetParam(port, parIdx, &parValue);
checkError("SetParam: ");
return;

} /* end setParam() */

/** EOF sf_car_xpc.c **/

*/
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e “Before You Start” on page 3-2
¢ “Example Visual Basic GUI Using COM Objects” on page 3-4



3 xPC Target™ COM API

Before You Start

This chapter describes how to write a custom application using the xPC
Target COM API. This COM API enables you to write COM applications to
load, run, and control an xPC Target application.

Before you start, read this section for guidelines on writing custom
applications based on the xPC Target COM API. You do not need to be a
seasoned C or C++ programmer to follow the procedures in this chapter, or
to write custom applications with the xPC Target COM API. You should,
however, have some rudimentary programming knowledge.

This chapter provides procedures on how to create xPC Target COM API
applications using Microsoft Visual Basic®:

® The procedures in this example use the model xpctank.mdl. If you want
to rebuild this model, or otherwise use the MATLAB software, you must
have xPC Target software version 2.0 or higher.

To determine which version of the software you are currently using, at
the MATLAB command line, type

xpclib

This opens the xPC Target Simulink blocks library. The xPC Target
software version of should be at the bottom of the window.

® You can work with xPC Target applications with either the MATLAB
software or an xPC Target COM API application. If you are working with
an xPC Target application using an xPC Target COM API application
simultaneously with a MATLAB session interacting with the target, keep
in mind that only one application can access the target PC at a time. To
move from the MATLAB session to your application, in the MATLAB
Command Window, type

close(xpc)

This frees the connection to the target PC for use by your xPC Target
COM API application. Conversely, you will need to have your COM API
application call the Close method to enable access to the target from a
MATLAB session.
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e Although you are building an xPC Target COM API application, you still
need to access the xpcapi.dll. When distributing the xPC Target COM
APIT application, place this file in one of the following, in order of preference:

= Directory from which application is loaded

= Windows® system directory
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Example Visual Basic GUI Using COM Objects

In this section...

“Introduction” on page 3-5

“Description of Simulink Water Tank Model” on page 3-5
“Creating a Simulink Target Model” on page 3-7
“Tagging Block Parameters” on page 3-8

“Tagging Block Signals” on page 3-11

“Creating the Target Application and Model-Specific COM Library” on page
3-14

“Model-Specific COM Interface Library (model_nameCOMiface.dll)” on
page 3-18

“Creating a New Microsoft® Visual Basic Project” on page 3-20

“Referencing the xPC Target COM API and Model-Specific COM Libraries”
on page 3-22

“Creating the Graphical Interface” on page 3-27

“Setting Properties” on page 3-29

“Writing Code” on page 3-31

“Creating the General Declarations” on page 3-33

“Creating the Load Procedure” on page 3-33

“Creating Event Procedures” on page 3-35

“Referencing Parameters and Signals Without Using Tags” on page 3-41
“Testing the Visual Basic Application” on page 3-45

“Building the Visual Basic Application” on page 3-45

“Deploying the API Application” on page 3-46

“Creating a New Visual Basic Project Using Microsoft® Visual Studio 7.1
or 8.0” on page 3-47
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Introduction

For demonstration purposes this chapter uses the Simulink model
xpctank.mdl and requests that you enter tags for signals and parameters

to create the Simulink model xpc_tank1.mdl. You will then build the
real-time target application xpc_tank1.d1lm and the GUI xpc_tank1_COM.exe
application using the xPC Target COM API library and Microsoft® Visual
Basic®.

Note These topics assume that you know how to create projects and forms
in Microsoft Visual Basic, and that you are familiar with the concept of
automatic code completion. For further details on Microsoft Visual Basic,
refer to your Microsoft product documentation.

Description of Simulink Water Tank Model

The xPC Target software includes the Simulink model xpctank.mdl. This is a
model of a water tank with a pump, drain, and valve controller.

Zxpctank * =|oj x|
File Edit ‘iew Simulakion  Formak Tools  Help
1 1
FurnpSwitch WaheeSwitzh  Gaing
1 ]
5 WA WIS IR : f »
- z ContmoWalue Giain Giaind Seope
SetPoint Contmler TanklLevel
o [2met Scops famet Seope
L d: 2 Id: 1
Seape (<PG) 1 Seape (<FC)
Tank Lewve| Gontml System
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TankLevel — The water level in the tank is modeled using a limited
integrator named TankLevel.

PumpSwitch — The pump can be turned off manually to override the action
of the controller. This is done by setting PumpSwitch to 0. When PumpSwitch
is 1, the controller can use the control valve to pump water into the tank.

ValveSwitch (drain valve) — The tank has a drain valve that allows water
to flow out of the tank. Think of this as water usage or consumption that
reduces the water level. This behavior is modeled with the constant block
named ValveSwitch, the gain block Gain2, and a summing junction. The
minus sign on the summing junction has the effect of producing a negative
flow rate (drain), which reduces the water level in the tank.

When ValveSwitch is 0 (closed), the valve is closed and water cannot flow out
of the tank. When ValveSwitch is 1 (open), the valve is open and the water
level is reduced by draining the tank.

Controller — The controller is very simple. It is a bang-bang controller and
can only maintain the selected water level by turning the control valve (pump
valve) on or off. A water level set point defines the desired median water
level. Hysteresis enables the pump to avoid high-frequency on and off cycling.
This is done using symmetric upper and lower bounds that are offsets from
the median set point. As a result, the controller turns the control valve (pump
valve) on whenever the water level is below the set point minus the offset.
The summing junction compares this lower bound against the tank water
level to determine whether or not to open the control valve. If the pump is
turned on (PumpSwitch is 1) water is pumped into the tank. When the water
level reaches or exceeds the set point plus the upper bound, the controller
turns off the control valve. When the water level reaches this boundary, water
stops pumping into the tank.

Scope blocks — A standard Simulink Scope block is added to the model for
you to view signals during a simulation. xPC Target Scope blocks are added
to the model for you to view signals while running the target application.
Scope 1d:1displays the actual water level and the selected water level in the
tank. Scope i1d:2 displays the control signals. Both scopes are displayed on the
target PC using a scope of type target.
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The xpctank.mdl model is built entirely from standard Simulink blocks and
scope blocks from the xPC Target software. It does not differ in any way from
a model you would normally use with the software.

Creating a Simulink Target Model

A target application model is a Simulink model that describes your physical
system and its behavior. You use this model to create a real-time target
application, and you use this model to select the parameters and signals you
want to connect to a custom graphical interface.

You do not have to modify this model when you use it with Simulink® 3D
Animation™ or other third-party graphical elements.

Create a target application model before you tag block parameters and block
signals to create a custom graphical interface:

1 In the MATLAB Command Window, type

xpctank

A Simulink model for a water tank opens. This model contains a set of
equations that describe the behavior of a water tank and a simple controller.

The controller regulates the water level in the tank. This model contains
only standard Simulink blocks and you use it to create the xPC Target
application.

2 From the File menu, click Save as and enter a new filename. For example,
enter xpc_tank1 and then click OK.

Note If you save your own copy of xpctank, be sure to be in the directory that
contains that model before calling it from the MATLAB window.

Your next task is to mark the block properties and block signals. See
“Tagging Block Parameters” on page 3-8 and “Tagging Block Signals” on page
3-11. Building an xPC Target application that has been tagged generates a
model-specific COM library, model nameifaceCOM.d1ll, which you can later
reference when writing your xPC Target COM API application.
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Tagging Block Parameters

Tagging parameters in your Simulink model enables you to generate a
model-specific COM library to provide access to model parameter IDs via the
xPC Target COM API library. These interface blocks contain the parameters
you connect to control devices (such as sliders) in your model. Tagging
parameters makes it easier for you to refer to these parameters later, when
you write your xPC Target COM API application.

Note If you do not tag parameters before you generate your Simulink model,
you must specify model parameters manually. See “Referencing Parameters
and Signals Without Using Tags” on page 3-41 for this procedure.

This procedure uses the modelxpc_tanki1.mdl (or xpctank.mdl) as an
example. See “Creating a Simulink Target Model” on page 3-7.

Note The xpctank model contains tags from the example for creating custom
user interfaces in the xPC Target User’s Guide . As you follow the procedures
in this section and the section “Tagging Block Signals” on page 3-11, you
should remove any existing tags before adding the new tags.

1 Open a Simulink model. For example, in the MATLAB window type
xpc_tank1 or xpctank.

2 Point to a Simulink block, and then right-click. For example, right-click the
SetPoint block.

3 From the menu, click Block Properties.

Cuk

Copy
Delete

Constant Parameters. ..

Block Properties. ..

A block properties dialog box opens.
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4 In the Description box, delete the existing tag and enter a tag to the
parameters for this block.

For example, the SetPoint block is a constant with a single parameter that
selects the level of water in the tank. Enter the tag shown below.

Description:

PCTag(1 1=water_lewvel, | -]

The tag has the following format:

xPCTag(1, . . . index_n)= label_1 . . . label_n;

e index_n — Index of a block parameter. Begin numbering parameters
with an index of 1.

® label n — Name for a block parameter to connect to a property for
the parameter you tag in the model. Separate the labels with a space,
not a comma.

label 1...label_n must consist of the same identifiers as those used by
C/C++ to name functions, variables, and so forth. Do not use names like
-foo.

You can assign multiple labels to one tag, such as

xPCTag(1)=1label;xPCTag(1)=1label2;

You might want to assign multiple labels if you want to tag a parameter
for different purposes. For example, you can tag a parameter to create
a model-specific COM library. You might also want to tag a parameter
to enable the function xpcsliface to generate a user interface template
model.

You can also issue one tag definition per line, such as

XxPCTag(1)=1label;
xPCTag(2)=1label2;
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5 Repeat step 4 for the remaining parameters you want to tag.

For example, for the Controller block, enter the tag

De=scription:
PCTagl1,2,3=upper _water_level lower _water_lewel pump_flu:uwrate;| ;I

[

For the PumpSwitch and ValveSwitch blocks, enter the tags

Description:
PCTag( J=pump_swwitch; -]
-
Description:
PCTagl1 1=drain_valve; :I

To tag a block with four properties, use the following syntax:

xPCTag(1,2,3,4)=1abel_1 label_2 label_3 label_4;

To tag a block with at least four properties for the second and fourth
properties, use the following syntax:

xPCTag(2,4)=1abel_1 label 2;
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6 From the File menu, click Save as. Enter a filename for your model. For
example, enter

xpc_tank1

You next task is to tag block signals, if you have not already done so; then,
create the model. See “Tagging Block Signals” on page 3-11.

Tagging Block Signals

Tagging signals in your Simulink model enables you to generate a
model-specific COM library to provide access to model signal IDs via the COM
API library. These interface blocks contain the signals you connect to display
devices (such as labels) in your model. Tagging signals makes it easier for
you to refer to these signals later, when you write your xPC Target COM
API application. After you tag signals, you will be ready to build your xPC
Target application.

Note If you do not tag signals before you generate your Simulink model,
you must specify model signals manually. See “Referencing Parameters and
Signals Without Using Tags” on page 3-41 for this procedure.

This procedure uses the model xpc_tank1.mdl (or xpctank.mdl) as an
example. See “Creating a Simulink Target Model” on page 3-7.

Note The xpctank model contains tags from the example for creating custom
user interfaces in the xPC Target User’s Guide. As you follow the procedures
in this section and the section “Tagging Block Parameters” on page 3-8, you
should remove any existing tags before adding the new tags.

Notice that you cannot select signals on the output ports of any virtual blocks
such as Subsystem and Mux blocks. Also, you cannot select signals on any
function call signal output ports.

1 Open a Simulink model. For example, in the MATLAB window type
xpc_tank1 or xpctank.
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2 Point to a Simulink signal line, and then right-click.

3 From the menu, click Signal Properties. For example, right-click the
signal line from the TankLevel block.

Signal Properties. ..

Linearization Painks b

A Signal Properties dialog box opens.
4 Select the Documentation tab.

E Signal Properties: {unnamed} 2=

Signal name: I

™| Signal name must rezalve to Simulink signal objsct

Logging and accesszibility | Real-Time *Workshop | Documentation |

Drezcription:

#PCT a1 j=water_level;

Document Link

ok, Cancel Help Apply

5 In the Description box, enter a tag to the signals for this line.

For example, the TankLevel block is an integrator with a single signal that
indicates the level of water in the tank. Enter the tag shown.

6 Repeat step 5 for the remaining signals you want to tag.
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For example, for the signal from the ControlValve block, enter the tag
pump_valve.

E: Signal Properties: {(unnamed) llil

Signal nanme; I

[T Signal name must resalve to Simulink signal objsct

Logging and accezzibility | Real-Time ‘Workshop | Docurnentation |

D escription:

4PCT ag=pump_walve]

Document Link,

ok Cancel Help Apply

Signal tags have the following syntax:

xPCTag(1, . . . index_n)=label 1 . . . label n;

¢ index_n— Index of a signal within a vector signal line. Begin numbering
signals with an index of 1.

® label n— Name for a signal to connect to a property for the signal you
tag in the model. Separate the labels with a space, not a comma.

label 1...label_n must consist of the same identifiers as those used by
C/C++ to name functions, variables, and so forth. Do not use names like
-foo.

For single-dimension ports, the following syntax is also valid:

XPCTag=label;
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You can assign multiple labels to one tag, such as

xPCTag(1)=1abel;xPCTag(1)=1abel2;

You might want to assign multiple labels if you want to tag a signal
for different purposes. For example, you can tag a signal to create a
model-specific COM library. You might also want to tag a signal to enable
the function xpcsliface to generate a user interface template model.

You can also issue one tag definition per line, such as

xPCTag(1)=1abel;
xPCTag(2)=1label2;

To tag a signal line with four signals (port dimension of 4) use the following
syntax:

xPCTag(1,2,3,4)=1abel_1 label_2 label 3 label_4;

To tag the second and fourth signals in a signal line with at least four
signals, use the following syntax:

xPCTag(2,4)=1label_1 label 2;

7 From the File menu, click Save as. Enter a filename for your model. For
example, enter

xpc_tank1

Create the target application. See “Creating the Target Application and
Model-Specific COM Library” on page 3-14.

Creating the Target Application and Model-Specific
COM Library

Use this procedure to create a target application that you want to connect
to a GUI application and the model-specific COM interface library
(model nameCOMiface.dll).

After you copy a Simulink model and tag the block parameters and block

signals, you can create a target application and download it to the target PC.
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This procedure uses the Simulink model xpc_tank1.mdl (or xpctank.mdl) as
an example (see “Creating a Simulink Target Model” on page 3-7).

1 Start or reset the target PC with an xPC Target boot disk in the floppy

drive. Ensure that there is no other application currently loaded on the
target PC.

2 If this is a new release of the product, ensure that you have configured the
host PC with the appropriate settings, including the compiler.

3 In the MATLAB window, type xpc_tank1 or xpctank.

A Simulink window opens with the model.md1 file.
4 From the Simulation menu, click Configuration Parameters.

The Configuration Parameters dialog is displayed for the model.
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#, Configuration Parameters: xpc_tank1/Configuration {Active)

Select:

Comments

d|

-~ Solver

- Data Import/Export
- Optimization

[#- Diagnostics
-Hardware Implementation
-~ Model Referendng
[+~ Simulation Target
eal-Time Warkshop
Report

Symbals
Custom Code

X
—Target selection =
System target file: |xpctarget.ﬂc Browse...
Language: IC j
Description: ¥PC Target
— Build process
Compiler optimization level: IOpﬁmizah’uns on (faster runs) LI
TLC ophions: I
Makefile configuration
¥ Generate makefile E
Make command: Imakﬂ_rtw
Template makefile: prl:_dEfELﬂt_tlTlf
Select objective: IUnspeciﬁed ;I
Check model before generating code: IOf‘F LI

Check model ...

o |

Cancel |

Help

The xPC Target options pane is displayed.

5 In the left pane, click the Real-Time Workshop node.

7 In the left pane, click the xPC Target options node.

6 In the Target selection section, click the Browse button at the RTW
system target file list. Click xpctarget.tlc if it is not already selected,
then click OK.
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8 Select the Build COM objects from tagged signals/parameters check
box.

—Miscellaneous options
[~ Double buffer parameter changes

[w Build COM objects from tagged signals/parameters
[ Generate CAMNape extensions

[ Include model Hierarchy on the target application

9 Click the Solver node.
The Solver pane is displayed.

10 Check that the Stop time is long enough for you to interact with the target
application.

11 Click OK to save and exit.

12 From the Tools menu, point to Real-Time Workshop, and then click
Build model.

Th e Real-Time Workshop, xPC Target, and a third-party C compiler
create the target application xpc_tank1.dlm and the COM object library
xpc_tanki1COMiface.dll. The target application is also downloaded to
the target PC.

13 If you want, you can close the MATLAB Command Window.

Note To create the target application and build associated COM objects from
the tagged signals and parameters, you must use the Visual C compiler. You
cannot use the Watcom compiler to build these COM objects.

Your next task is to create a Microsoft Visual Basic API application using
COM objects. This API application connects and controls the target
application. See “Creating a New Microsoft® Visual Basic Project” on page

3-17



3 xPC Target™ COM API

3-18

3-20. For more information about model-specific COM interface library,
refer to “Model-Specific COM Interface Library (model_nameCOMiface.dll)”
on page 3-18.

Model-Specific COM Interface Library
(model_nameCOMiface.dll)

The generated model-specific COM interface library is a DLL component
server library that enhances programming using the xPC Target COM API
library. A model-specific COM interface library is specific to the model from
which it is generated; do not reference a model-specific library for another
model. If you choose not to generate a model-specific COM interface library,
refer to “Referencing Parameters and Signals Without Using Tags” on page
3-41 for a description of how to otherwise reference parameters and signals in
the xPC Target COM API application.

The mode-specific COM interface library allows users easy access to
preselected tagged signals and desired tagged parameters for use in
conjunction with the xPC Target COM API xPC Target and xPCScope
object signal monitoring and parameter member functions such as
xPCTarget.GetParam, xPCTarget.SetParam, and xPCTarget.GetSignal.

The xPC Target COM generated objects are of two types:

* model_namebio

* model_namept

where model_name is the name of the Simulink model. The model_namebio
type is for tagged block I/O signals and the model namept type is for tagged
parameters.

Model-Specific COM Signal Object Classes

Model-specific COM signal classes have two types of members in which you
are interested, the Init function and class properties. You will find these
members in the model_namebio class, where model_name is the name of
your model.
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The Init function invokes the Init method once, passing it the Ref
property from the xPCProtocol class. This method initializes the object to
communicate with the appropriate target PC to access the signal identifiers
when accessing the object’s properties. Refer to the call in the Microsoft
Visual Basic code example in “Creating the Load Procedure” on page 3-33.

Each class has a list of properties (specified in the Tag syntax in the
Description field of the signal property). These properties return the
xPC Target signal identifiers or signal numbers of the tagged signals.
The generated property name is the name specified in the tagged signal
description using the following syntax:

xPCTag=Property name;

For example, in the model xpc_tank1.mdl, there are two signal tags in the
Description field:

® The output from the integrator block labeled TankLevel is tagged
xPCTag=water_level.

® The output from the multiply block labeled ControlValve is tagged
xPCTag=pump_valve.

Model-Specific COM Parameter Object Classes

Model-specific COM signal classes have two types of members in which you
are interested, the Init function and class properties. You will find these
members in the model_namept class, where model_name is the name of your
model.

The Init function invokes the Init method once, passing it as input the
Ref property from the xPCProtocol class. This method initializes the object
to communicate with the appropriate target PC to access the parameter
identifiers when accessing the object’s properties. Refer to the call in the
Microsoft Visual Basic code example in “Creating the Load Procedure” on
page 3-33.

Each class has a list of properties (specified in the Tag syntax in the

Description field of the block property). These properties return the xPC
Target parameter identifiers of the tagged parameters. The generated
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property name 1s the name specified in the tagged signal description using
the following syntax:

xPCTag(1)=Property name;

For example, in the model xpc_tank1.mdl, there are two parameter tags in
the Description field:

® The parameter for SetPoint blocks is tagged xPCTag=set water_ level;

® The parameters for the Controller block are tagged
xPCTag(1,2,3,)=upper_water_level lower_water_level
pump_flowrate;

Creating a New Microsoft Visual Basic Project

The following procedures describe how you can create a Microsoft Visual Basic
project to take advantage of the xPC Target COM API to create a custom
GUI for the xPC Target application. The procedures build on the xpctank
(xpc_tank1) model you saved earlier (see “Creating the Target Application
and Model-Specific COM Library” on page 3-14). The Microsoft Visual Basic
environment allows you to interact with your target application using a GUI
while the target application is running in real time on the target PC.

The procedures for the following topics apply to Microsoft® Visual Studio® 6.0.
To use Microsoft Visual Studio 7.1 or 8.0 instead, see “Creating a New Visual
Basic Project Using Microsoft® Visual Studio 7.1 or 8.0” on page 3-47.

1 Create a new project directory.

From the directory matlabroot\toolbox\rtw\targets\xpc\api, copy the
file xpcapi.dll (API library) to this new project directory. Alternatively,
you can copy the file xpcapi.dll into the Windows system directory.

You do not need to copy xpcapiCOM.d1l (the COM API library) into the
current directory, but ensure that it is registered in your system (see
“Registering Dependent Dynamic Link Libraries” on page 3-47.)

2 From your MATLAB working directory, copy the files model name.dlm
(target application) and model nameCOMiface.dll (model-specific COM
library) to the new project directory.
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3 While in this project directory, open Microsoft Visual Basic. From the File
menu, click New Project.

The New Project dialog box opens.

Note Be sure to open the Microsoft Visual Basic project from the project
directory itself, not from Microsoft Visual Basic.

4 Select Standard EXE, and then click OK.

The Microsoft Visual Basic Integrated Development Environment opens
with a blank form.

w. Projectl - Forml (Form) - |EI|£|

(m] O ]

5 From the File menu, click Save Project As and enter a filename for the
form and the project. For example, for the form, enter

xpc_tank1_COM. frm

At the project prompt, enter
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xpc_tank1_COM.vbp

Referencing the xPC Target COM API and

Model-Specific COM Libraries

You need to reference the xPC Target COM API and model-specific COM
libraries so that Microsoft Visual Basic will use them in the current project.
Assuming that you created the Visual Basic project as described in the
preceding procedure, reference the library as described in this procedure:

1 From the Project menu, click References.
The References dialog box opens.

2 Select the COM tab.

3 Scroll down the Component Name list to the bottom. Select the xPC
Target API COM Type Library check box.

4 Click Select.
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5 Click OK.

References - xpc_tank_COM.vbp

Hvailable References:

Ik

[Twindows Media Player UL

['windows Media Streamer Plugin Type Library
[]'Windows Script Host Object Model (Yer 1,00
[Twizard15 1.0 Type Library

[TwmdmLog 1.0 Type Library

[]%WMI ADSI Extension Type Library
[CIWMICnt 1.0 Type Library
[TwMsClientMetManager 1.0 Type Library
[JWwProbkj 1.0 Type Library

[I'wUpdInfo 1.0 Type Library

[l wenrall 1,0 Tvpe Librar
APT 20 Twpe Library
[Jxpc_tanklCOMiface 1.0 Type Library

al |

—%PC Target APT COM Type Library

Cancel

Al
Browse, ..

4

Priarity

o
o

Help

i

Location:

Language: Standard

[ hworklxpoinewtestinew_vb_testixpoapiCorM, dll

The xPC Target COM API Type library (xpcapiCOM.d11) is now available

for use in your project.

6 To add the model-specific COM library, click References again from the

Project menu.

The References dialog box opens.

7 Scroll to find your model name. Select the check box xpe_tank1COMiface

1.0 Type Library.
8 Click Select.
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9 Click OK.

References - xpc_tank_COM.vbp

Hvailable References:

[CTwindows Media Player CiC
[Twindows Media Player UL
[]'Windows Media Strearmer Plugin Type Library
[wWindows Scripk Host Object Madel (ver 1,00
[Twizard15 1.0 Type Library

[J*Wrmdmlog 1.0 Type Library

[]WwMI ADSI Exkension Type Library
[1'WMICnt 1.0 Type Library
[JWMsClientMetManager 1.0 Type Library
[1'wPoObi 1.0 Type Library

[JwUpdinfo 1.0 Type Library

[senrall 1.0 Type Librar
vpe FanklCOMiface 1.0 Tvpe Library

al |

4

Priarity

K1

Ik

Cancel

Browse, ..

Help

i

—xpc_tanklCOMiface 1.0 Type Library

Language: Standard

Location:  dilyworklxpc_tanklixpc_tankl x<pc_rbwixpc_tanklCOMiface.c

The model-specific COM API Type Library (xpc_tanki1COMiface.dll) is
now available for use in your project. Sections “Viewing Model-Specific
COM Signal Object Classes” on page 3-25 and “Viewing Model-Specific

COM Parameter Object Classes” on page 3-26 describe how to look at class

objects.

Because the xPC Target COM API is an add-on to Visual Basic, it might
help to know a bit about Visual Basic before going much farther with using
the COM API. The section “Creating the Graphical Interface” on page 3-27
guides you through using Visual Basic to create a project for the xpctank

or (xpc_tank1) model.
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Viewing Model-Specific COM Signal Object Classes

After you create a Visual Basic project and reference the xPC Target COM
API and model-specific COM libraries, you can use the Visual Basic Object
browser (click the View menu and select Object Browser) to look at the
objects for the xpctankbio or xpc_tankibio class:

1 From the View menu, select Object Browser.

A dialog box pops up with a drop-down list containing all the type library
information for a project.

2 Select the drop-down list for the project/library.

A list of the project libraries appears.

=i Object Browser

2 R A e ] e

=101 x|

<All Libraries=-

<All Libraries=

Project1 M
rstdﬂle embers of '=globalss"

o 2
= vBRUN i App

5 XPC TANKACOMIFACELib

_ i AppActivate
XPCAPICOMLIib

i P Az
21 app =% AccH
2F ApplicationStartCons = Ascw
1 AsyncProperty =S Afn

B AsyncProperty vBS *||=® Beep

=All Libraries=

3 Select model_nameCOMIFACELib.
The classes in your model appear.

4 To view the objects of a class, select that class.
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The objects in your class appear.

The xpctankbio (or xpc_tankibio) class contains the function Init and
the two properties

® water_level

® pump_valve

Viewing Model-Specific COM Parameter Object Classes

After you create a Visual Basic project and reference the xPC Target COM
API and model-specific COM libraries, you can use the Visual Basic Object
browser (click the View menu and select Object Browser) to look at the
objects for the xpctankpt or xpc_tankipt class:

1 From the View menu, select Object Browser.

A dialog box pops up with a drop-down list containing all the type library
information for a project.

2 Select the drop-down list for the project/library.
A list of the project libraries appears.

3 Select model_nameCOMIFACELib.
The classes in your model appear.

4 To view the objects of a class, select that class.

The objects in your class appear.

The xpctankpt (or xpc_tankipt) class contains the method Init and the
member properties

® pump_switch

® upper_water_level

® lower_water_level

* pump_flowrate
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® water_level

® drain_valve

Creating the Graphical Interface

Forms are the foundation for creating the interface of a Visual Basic
application. You can use forms to add windows and dialog boxes to your
Visual Basic application. You can also use them as containers for items that
are not a visible part of the application’s interface. For example, you might
have a form in your application that holds a timer object.

The first step in building a Visual Basic application is to create the forms that
are the basis for your application’s interface. Then you create the objects that
make up the interface on the forms. This section assumes that you have a
Visual Basic project (see “Creating a New Microsoft® Visual Basic Project”

on page 3-20). For this first application, you will use four types of controls
from the toolbox:

¢ Button

* Timer

e Label
e Scrollbar

1 Open xpc_tank1_COM.vbp

2 On the left, from the General tool panel, click and drag the Button icon
— to the form to create a button.

3 Repeat for a second button.

4 If you want to view signal data on the host, return to the General tool

panel and click and drag the Timer icon 2 to the form to create a timer.

5 If you want to view signal data on the host, add a Label control to the form.

Return to the General tool panel and click and drag the Label icon A to
the form to create a label.
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6 If you want to be able to vary the parameter input to the target, return

to the General tool panel and click and drag the HScrollBar icon X
to the form.

7 Next, name your new form objects. Right-click the first button and select
Properties. This brings up the Properties dialog box. In the Caption box,
enter Load. Repeat for the second button, but enter Start. Repeat for
the third button, but enter Stop. (If you are unsure about how to work
with properties, refer to the procedure “Setting Properties” on page 3-29.)
After you name your new form objects and set whatever other parameters
you want (for example, if you use a timer you must increase the Interval
parameter), you can write the code behind these objects using the Visual
Basic code editor window (refer to “Writing Code” on page 3-31).

If you added a scroll bar to your project, it should look similar to the figure
below.

. Projectl - Forml (Form)

If you added a timer and label to your project, it should look similar to
the figure below.
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Note If you add a timer, remember to increase the interval of the timer to

a value greater than the default value of 0. Right-click the timer and select
Properties. This brings up the Properties dialog box. In the Interval box,
enter a value greater than 0, for example, 100.

. Prijectl - Forml (Form)

Setting Properties

This procedure describes how to set properties for the Visual Basic objects you
created on your form. If you already know how to set properties for Visual
Basic objects, proceed to “Writing Code” on page 3-31.
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The Properties window in the following figure provides an easy way to
set properties for all objects on a form. To open the Properties window,
choose the Properties Window command from the View menu, click the
Properties Window button on the toolbar, or use the context menu for the
control.

Properties - Form1 E3
[Form1 Form ] Object box
Alphabetic ICategnrized I Sort tubs
tMamne) Form1 =
Appearance 1-30 Properties [t
AutoRedran False
EackiColor [] aHsoo0000F
BorderSkyvle 2 - Sizable
Zapkion Form1
lipControls True
ZontrolBox True b
Drrawiode 13 - Copy Pen
DirawSkyle 0 - Solid
Dirawifidth 1
Enabled True
Fill Calar B :Hooooooo;
Fill Skyle 1 - Transparent
Fonk M3 Sans Serif
FonkTransparent |True
ForeColor B =Hsoo00012
HasDnZ True
Height 3570 ;I

{Mame)
Returns the name used in code ko
idenkify an object,

The Properties window consists of the following elements:

® Object box — Displays the name of the object for which you can set
properties. Click the arrow to the right of the object box to display the
list of objects for the current form.
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® Sort tabs — Choose an alphabetic listing of properties or a hierarchical
view divided by logical categories, such as those dealing with appearance,
fonts, or position.

® Properties list — The left column displays all the properties for the selected
object. You can edit and view settings in the right column.

To set properties from the Properties window,

1 From the View menu, choose Properties, or click the Properties button
on the toolbar.

The Properties window displays the settings for the selected form or
control.

2 From the properties list, select the name of a property.
3 In the right column, type or select the new property setting.

Enumerated properties have a predefined list of settings. You can display
the list by clicking the down arrow at the right of the settings box, or you
can cycle through the list by double-clicking a list item.

You can also set object properties directly in the code by using the following
dot notation: Object.propertyname=value.

Writing Code

The code editor window is where you write Visual Basic code for your
application. Code consists of language statements, constants, and
declarations. Using the code editor window, you can quickly view and edit
any of the code in your application.

The code editor window has three panes. The top leftmost pane is the object
list box. It is a dropdown list that contains all the form controls in your
project, plus a general section for generic declarations. The top rightmost
pane contains a procedure list box. For the selected or active control in the
object list box, the procedure list box displays the available procedures, or
events. Visual Basic predefines the possible procedures. The third pane
contains the code for the Visual Basic application. See the following figure for
a sample code editor window.
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M Projectl - Formi (Code) _|_|- 0 ﬂ
I(General} j I(Declaratiuns) j
| B
I
== | LHJ

In the general declarations section, declare a reference to the xPC Target
COM objects that you are using to interface with the xPC Target objects. The
following are the objects you need to declare:

® xPCProtocol — Reference the classes corresponding to the target PC
running the target application and initialize the xPC Target API dynamic
link library. At a minimum, you must declare this object.

e xPCTarget — Reference the classes for interfacing with the target
application. At a minimum, you must declare this object.

® xPCScope — If the API application requires signal data, reference the class
for interfacing with xPC Target scopes. You need to declare a scope if you
want to acquire data from scopes or display data on scopes.

¢ model namept — This is the COM object for tunable model/application
parameters.

® model namebio — This is the COM object for model/target application
signals.
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Creating the General Declarations

This procedure describes how to create the general object declarations for
the xpctank (or xpc_tank1) model:

1 Double-click the form or, from the View menu, select Code.
The code editor window box opens for the control.

2 Select the General object.

3 Select Declarations in the procedure list box.

A template for the declarations procedure is now displayed in the code
editor window.

4 Enter declarations for the xPC Target COM objects you are using.

Public protocol_obj As xPCProtocol
Public target_obj As xPCTarget
Public scope_obj As xPCScopes

5 Enter declarations for the model-specific COM objects you are using.

Public parameters_obj As xpc_tankipt
Public signals_obj As xpc_tankibio

Creating the Load Procedure

This procedure describes how to program a load target application procedure
for the form. You might or might not want to allow users to download target
applications to the target PC. However, if you do want to allow this action,
you need to provide a control on the GUI for the user to do so. “Creating
Event Procedures to Load Applications” on page 3-36 describes how to provide
such a control.

1 In the project window, double-click the Form object.
The code editor window opens.

2 In the procedure list box, select Load.
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3 Create and initialize the objects for the Load method in the form. Note that
the following code also checks that the initialization of the protocol obj
succeeds. If it does not succeed, an error message is returned and the
application will exit.

Private Sub Form_Load()
Set protocol_obj = New xPCProtocol
Set target_obj = New xPCTarget
Set scope_obj = New xPCScopes
Set parameters_obj = New xpc_tankipt
Set signals_obj = New xpc_tankibio
stat = protocol_obj.Init
If stat < 0 Then
MsgBox("Could not load api") 'We can no longer continue.
End
End If
stat = protocol_obj.RS232Connect (0, 0)
stat = target_obj.Init(protocol_obj)
stat = scope_obj.Init(protocol_obj)
stat = parameters_obj.Init(protocol_obj.Ref)
stat = signals_obj.Init(protocol_obj.Ref)
End Sub

You can add more code to the Load method. This is the minimum code
you should enter for this method.
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Your code editor window should look similar to the following.

M Project1 - Forml {Code)
IFurm j ILuad

Dim protocol _obj Ais =xPCProtocol

D?m target ob] As xPCTarget
Dim scope_ob] As xPC3copes

Dim parameters_ob] As xpc_tanklpt
Dim =ignals ob]j A= xpe tanklbio

Private Sub Form Load(]
Zet protocol obj = New xPCProtocol
Set target okhj = HNew xPCTarget
Set scope obj = New XPC3copes
Set parameters obj = New xpc tanklpt
Zet signals obj = MNew xpc tanklbio

stat = protocol obj.Init
stat = protocol obj.R3Z3ZConnect (0, 0)
stat = target obj.Init(protocol obj)

stat = scope_obj.Init (protocol obj)

stat = parameters obj.Init (protocol obj.Ref)

stat = signals obj.Init(protocol obj.Ref)
End Zub

Creating Event Procedures

Code in a Visual Basic application is divided into smaller blocks called
procedures. Event procedures, such as those you create here, contain code
that mainly calls the xPC Target API component methods. For example, when
a user clicks a button, that action starts the xPC Target application.

This code is also responsible for the feedback action (such as enabling a
timer control, disabling/enabling controls) when an event occurs. An event
procedure for a control combines the control’s name (specified in the Name
property), an underscore (_), and the event name. For example, if you want
a command button named Command]1 to invoke an event procedure when
it is clicked, call the procedure Commandi1_Click. The following procedures
illustrate how to create event procedures, using the xpctank (or xpc_tank1)
model as an example.
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Creating Event Procedures to Load Applications

This procedure describes how to program the command button Command]1
to load an application to the target PC through a serial connection. Provide

a procedure like this to allow users to download target applications to the
target PC.

1 Double-click the form or, from the View menu, select Code.

2 From the object list box, select the name of an object in the active form.
(The active form is the form that currently has the focus.) For this example,
choose the command button Command]1.

3 In the procedure list box, select the name of an event for the selected object.

Here, the Click procedure is already selected because it is the default
procedure for a command button.

ME Projectl - Forml (Code) _ o] x|

IComnmmH ﬂ ICIick ﬂ

Private Sub Commandl Click () -
End 3ub
=4 AV

4 To load the target application, enter the path to the target application. If
the target application is in the same folder as the API application, enter ".".
Enter the name of the target application without the extension.

stat = target_obj.LoadApp(".", "xpc_tank1l")

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Command1_Click()
stat = target_obj.LoadApp(".", "xpc_tank1l")
End Sub
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Creating Event Procedures to Start and Stop Applications

This procedure describes how to program the command buttons Command2
and Command3 to start and stop an application on a target PC:

1 If you are not already in the code editor window, double-click the form or,
from the View menu, select Code.

2 From the object list box, select the name of an object in the active form.
(The active form is the form that currently has the focus.) For this example,
choose the command button Command2.

3 In the procedure list box, select the name of an event for the selected object.
Here, select the Click procedure.

4 To start the target application, select the StartApp method for the
command button Command2 (this is the button you named Start).

stat = target_obj.StartApp

5 To stop the target application, select the StopApp method for the command
button Command3 (this is the button you named Stop). Be sure to select
the Click procedure in the procedure list box.

stat = target_obj.StopApp

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Command2_Click()
stat = target_obj.StartApp
End Sub

Private Sub Command3_Click()
stat = target_obj.StopApp
End Sub

Creating Event Procedures to Vary Input Values

You can provide controls to allow users to vary the parameters of their
applications. The Scroll procedure is one way of varying input. The following
code uses the Visual Basic HScrollBar object to vary the water_level
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parameter. It takes the value from the HScrollBar object and sends that
value to the target as a parameter change.

Note This section assumes that you have tagged block parameters and
created your own model-specific COM library. Refer to “Getting Parameter
IDs with the GetParamldx Method” on page 3-41 for a description of how to
manually perform the equivalent of using tagged parameters.

1 If you are not already in the code editor window, double-click the form or,
from the View menu, select Code.

2 From the object list box, select the name of an object in the active form.
(The active form is the form that currently has the focus.) For this example,
select the HScroll1 object.

The cursor jumps to the HScroll1 object template of the code editor window.

3 In the procedure list box, select the name of an event for the selected object.
Here, select the Scroll procedure.

4 Declare the slideVal variable as a double. The slideVal variable will
contain the value of the scrollbar.

Dim slideVal(0) As Double

5 Assign to the slideVal variable the result of CDbl. The CDb1 function
reads the value of an object property. In this example, the object HScroll1
has the property slidevVal(0). CDbl reads the value of HScrolli.Value
and returns that value to slideVval.

slideVal(0) = CDbl(HScrolll.Value)

6 Set the value of water_level to the scroll bar value slideVal, which is
from HScrollBar. The COM object target_obj has the method SetParam,
which has the syntax SetParam(parIdx, newparVal). The SetParam method
references parIdx from the model-specific COM object (type xpc_tankipt).
To set the value of water_level to the scroll bar value slideVal, select
SetParam and continue typing. A list of the parameters you tagged in
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the Simulink model then pops up, and you can select the parameter
water_level and continue typing.

The call to SetParam should look like the following:

stat = target_obj.SetParam(parameters_obj.water_level,
slideVal)

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub HScrolli1_Scroll()
Dim slideVal(0) As Double

slideVal(0) = CDbl(HScrolli.Value)

stat = target_obj.SetParam(parameters_obj.water_level,
slideVal)
End Sub

Creating Event Procedures to Display Signal Values at the Host
You can provide controls to view signal values at the host. To do this, use a
combination of the timer and label controls. The following code uses the Visual
Basic timer control to display the water_level signal on the label control.

Note This section assumes that you have tagged signals and created your
own model-specific COM library. Refer to “Getting Signal IDs with the
GetSignalldx Method” on page 3-43 for a description of how to manually
perform the equivalent of using tagged signals.

Before you start, check that the Timer1 Interval property is greater than 0.

1 From the object list box, select the Timer1 object.

2 Assign to the Label1.Caption object the value of the water_level signal.
The COM object target_obj has the method GetSignal(sigNum). Reference
the sigNum parameter by passing it signals_obj.water_level. The CStr
function converts the returned value to a string so that it can be displayed
on the Label1 object.
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When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Timer1_Timer()

Labell1.Caption =
CStr(target_obj.GetSignal(signals_obj.water_level))
End Sub

Note Although you add both a timer and label object to the Visual Basic
application, only the label appears on the GUI itself when the Visual Basic
application is run. The timer is not visible.

Creating Unload and Termination Procedures

You should write Form Unload and Termination procedures to ensure that
users are able to stop and unload the application appropriately, and to close
the communication between the host PC and target PC.

Note Provide Form Unload and Termination procedures to ensure that the
communication channel between the host PC and target PC properly closes
between each run of the GUI application.

The Terminate procedure controls the behavior of the Visual Basic Run
menu End option. The Unload procedure controls the behavior of the Visual
Basic Close button.

1 From the object list box, select the Form object.
2 From the procedure list box, select Terminate.

3 You are going to close the connection with the target PC, so type
protocol obj and select the Close method for that object.

protocol_obj.Close

4 From the procedure list box, select Unload.
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5 Repeat step

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Form_Terminate()
protocol obj.Close

End Sub

Private Sub Form_Unload(Cancel As Integer)
protocol obj.Close

End Sub

Referencing Parameters and Signals Without Using
Tags

The sample code in “Creating Event Procedures to Vary Input Values” on
page 3-37 and “Creating Event Procedures to Display Signal Values at the
Host” on page 3-39 illustrates how to reference parameters that you tagged
before building the Simulink model. This section describes how to reference
these same parameters and signals from the COM API application code if you
did not opt to tag signals and parameters.

Getting Parameter IDs with the GetParamldx Method

When working with parameters in the context of varying input values, you
use the SetParam and GetParamIdx methods. The SetParam method has
the syntax

SetParam(ByVal parIdx As Integer, ByRef newparVal As
System.Array) As Long

where parIdx is the identifier that corresponds to the parameter you want to
set. To obtain the parameter ID, parIdx, for SetParam, you need to call the
GetParamIdx method. This method has the syntax

GetParamIdx(ByVal blockName As String, ByVal paramName As
String) As Long

The following procedure describes how to obtain the appropriate GetParamIdx
block name and parameter name for the Visual Basic HScrollBar object. You
need to reference the block name and parameter from the model namept.m
file.
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1 Open a DOS window.
2 Change the directory to the directory that contains your prebuilt model.

3 Open the file model namept.m. For example, you can use the notepad
text editor.

notepad xpc_tankipt.m

The editor opens for that file. If you are not in the directory in which the
xpc_tank1pt.m file resides, be sure to type the full path for xpc_tankipt.m.

4 Search for and copy the string for the block of the parameter you want to
reference. For the xpc_tank1 example, search for the SetPoint block if you
want to reference the water level. For example,

SetPoint

5 Return to the code editor window for your project.

6 In the line that contains the call to GetParamIdx, enter the path for the
blockName variable.

7 Return to the editor window for model_namept.m.

8 Search for and copy the string for the name of the parameter you are
interested in. For example,

Value

If you do not know the name of the block parameter you are interested
in, refer to “Model and Block Parameters” of the Simulink Reference
documentation.

9 Return to the code editor window for your project.

10 In the line that contains the call to GetParamIdx, enter the path for the
paramName variable. For example,

stat = target_obj.SetParam(target_obj.GetParamIdx
("SetPoint", "Value"), slideVal)
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When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub HScrolli1_Scroll()
Dim slideVal(0) As Double

slideVal(0) = CDbl(HScrolli.Value)

stat =
target_obj.SetParam(target_obj.GetParamIdx
("SetPoint", "Value"), slideVal)

End Sub

Note, if you want to retrieve the full block path and parameter name of a
block, use the GetParamName method. The GetParamName method returns a
variant data type object with two elements. The first element contains the full
block path, the second element contains the parameter name. The following
example illustrates how to use the GetParamName method to get the block
path and parameter name:

Dim Pname As Variant
Pname=xpc_tank1.GetParamName (GetParamIdx (Idx)
BlockPathString=CStr(Pname(0))
ParameterNameString=CStr(Pname(1))

In this example,

® Idx is the index to a parameter.
® BlockPathString contains the full block path string.

® ParameterNameString contains the parameter name string.

Getting Signal IDs with the GetSignalldx Method

When working with signals in the context of displaying signal values, you
use the GetSignal and GetSignalldx methods. The GetSignal method has
the syntax

GetSignal(sigNum As Long) As Double

where sigNum is the identifier that corresponds to the signal you want to set.
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To obtain the signal ID sigNum for GetSignal, you call the GetSignalIdx
method. This method has the syntax

GetSignalIdx(sigName As String) As Long

The following procedure describes how to obtain the appropriate
GetSignalIdx block name for the Visual Basic timer object. You need to
reference the block name and signal from the model_namebio.m file.

1 Open a DOS window.
2 Change the directory to the directory that contains your prebuilt model.
3 Open the file model namebio.m. For example,

notepad xpc_tankibio.m

The editor opens for that file. If you are not in the directory in which
the xpc_tankibio.m file resides, be sure to type the full path for
xpc_tankibio.m.

4 Search for and copy the string for the block of the signal you want to
reference. For the xpc_tank1 example, search for the TankLevel block to
reference the tank level. For example,

TankLevel

5 Return to the code editor window for your project.

6 In the line that contains the call to GetSignallIdx, enter the path for the
SigName variable.

When you are done, the contents of your code editor window should look
similar to the code below:

Private Sub Timeri1_Timer()
Labelt.Caption =
CStr(target_obj.GetSignal(target_obj.GetSignalIdx("TankLevel"

)))
End Sub
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Testing the Visual Basic Application

While creating your Visual Basic application, you might want to see how the
application is progressing. Visual Basic allows you to run your application
while still in the Visual Basic project. From the Visual Basic task bar, you
can click the Run button » . Alternatively, you can follow the procedure:

1 If you have the MATLAB interface and a target object connected, close the
port. For example, at the MATLAB command line, type

tg.close

2 From within the project, go to the Run menu.

3 Select Start or Start with Full Compile. The Start option starts your
application immediately. The Start with Full Compile option starts
the application after compilation.

The form you are working on pops up. Test your application. Ensure that
only one version of the application is running at any given time. To stop the

application from within Visual Basic, you can click the End button B fom
the task bar. Alternatively, you can go to the Run menu and select End.

Note If your Visual Basic application opens a communication channel
between the host PC and the target PC for the target application, be sure to
close that open channel between test runs of the Visual Basic application. Not
doing so can cause subsequent runs of the Visual Basic application to fail.
“Creating Unload and Termination Procedures” on page 3-40 describes how
to write a procedure to disconnect from the target PC. If you want to return
control to the MATLAB interface, be sure to close the Visual Basic project first.

Building the Visual Basic Application

After you finish designing, programming, and testing your Visual Basic
GUTI application, build your application. You can later distribute the GUI
application to users, who can then use it to work with target applications.

1 From within the project, go to the File menu.
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2 Select Make project name_COM.exe, where project name is the name of
the Visual Basic project you have been working on.

3 At the pop-up box, select the directory in which you want to save the
executable. Optionally, you can also rename the executable.

The compiler generates the project_name_COM.exe file in the specified
directory.

Deploying the API Application

This section assumes that you have built your xPC Target application and
your Visual Basic xPC Target COM GUI application. If you have not yet
done so, refer to “Creating the Target Application and Model-Specific COM
Library” on page 3-14 and “Building the Visual Basic Application” on page
3-45, respectively.

When distributing the Visual Basic model application to users, provide the
following files:

® project_name_COM.exe, the executable for the Visual Basic application
* model_name.dlm

Provide model name.d1lm if you expect the user to download the target
application to the target PC. Ensure that you have enabled an application
load event on the Visual Basic interface (refer to “Creating the Load
Procedure” on page 3-33).

If you expect that the target application is already loaded on the target PC
when the user runs the Visual Basic GUI application, you might not want
him or her to be able to load the target application to the target PC.

* model nameCOMiface.dll, if you tag the signals and parameters in the
model

® xpcapiCOM.d1ll, the xPC Target COM API dynamic link library
e xpcapi.dll, the xPC Target API dynamic link library

Have the user ensure that all the files are located in the same directory before
he or she executes the Visual Basic application.
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You must also ensure that the user knows how to register the

application-dependent dynamic link libraries (refer to “Registering Dependent
Dynamic Link Libraries” on page 3-47).

To run the application and download an xPC Target application, users need
to have project _name_COM.exe and model name.dlm, if provided, in the
same directory.

Registering Dependent Dynamic Link Libraries
This procedure uses xpc_tank1 as an example.

1 Open a DOS window.

2 Change the directory to the directory containing the API application files.

3 From the directory in which xpcapiCOM.d11 resides, register the xPC
Target COM API DLL by typing

regsvr32 xpcapiCOM.d1ll
DOS displays the message

D11RegisterServer in xpcapiCOM.dll succeeded

Creating a New Visual Basic Project Using Microsoft
Visual Studio 7.1 or 8.0

The procedures for the preceding topics apply to Microsoft Visual Studio

6.0 (“Creating a New Microsoft® Visual Basic Project” on page 3-20). The
procedures to use Microsoft Visual Studio 7.1 (NET 2003) and 8.0 are similar,
with the following exceptions. Note that references toMicrosoft Visual Studio
7.1 or NET 2003 also apply to Microsoft Visual Studio 8.0.

® You can open a Microsoft Visual Studio 6.0 project under Microsoft Visual
Studio .NET 2003. Microsoft Visual Studio .NET 2003 automatically
converts the project.

¢ [f you first create a new Visual Basic project, select Windows Application
as the template.

® When referencing the xPC Target COM API and model-specific COM
libraries, do the following
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1 From the Project menu, click Add Reference.

The Add Reference dialog box opens.
2 Select the COM tab.

3 Scroll down the Component Name list to the bottom and select the
xPC Target API COM Type Library item.

4 (Click Select.

xPC Target API COM Type Library appears in the Selected
Components pane.

5 Click OK.

When creating a reference to the xPC Target interface objects, include the
COM library. The following illustrates example code on how to reference
these objects in Microsoft Visual Studio .NET 2003 and Microsoft Visual
Studio6.0:

Microsoft Visual Studio .NET 2003

Public protocol_obj As XPCAPICOMLib.xPCProtocol
Public target_obj As XPCAPICOMLib.xPCTarget
Public scope_obj As XPCAPICOMLib.xPCScopes

Microsoft Visual Studio 6.0

Public protocol_obj As xPCProtocol
Public target_obj As xPCTarget
Public scope_obj As xPCScopes

When creating an instance of the xPC Target interface objects, include
the COM library. The following illustrates example code on how to create
an instance of these objects in Microsoft Visual Studio .NET 2003 and
Microsoft Visual Studio 6.0:

Microsoft Visual Studio .NET 2003
protocol_obj = New XPCAPICOMLib.xPCProtocol

target_obj = New XPCAPICOMLib.xPCTarget
scope_obj = New XPCAPICOMLib.xPCScopes
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Microsoft Visual Studio 6.0:

Set protocol_obj = New xPCProtocol
Set target_obj = New xPCTarget
Set scope_obj = New xPCScopes

e Microsoft Visual Studio .NET 2003 builds applications into the bin
directory of your project area. You cannot choose another location to place
your executable.

e When distributing the Visual Basic model application to users, provide the
following files in addition to those listed in “Deploying the API Application”
on page 3-46:

= Interop.model_nameACOMIFACELib.d1l1l
= Interop.XPCAPICOMLib.d1ll
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® “Microsoft® Visual Basic 7.1 (NET 2003) Demo” on page 4-2
e “Microsoft® Visual Basic 6.0 Demo” on page 4-5

e “Tcl/Tk Scripts” on page 4-8
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Microsoft Visual Basic 7.1 (.NET 2003) Demo

In this section...

“Introduction” on page 4-2
“Before Starting” on page 4-3
“Accessing the Demo Project Solution” on page 4-3

“Rebuilding the Demo Project Solution” on page 4-4

“Using the Demo Executable” on page 4-4

Introduction

To help you better understand and quickly begin to use COM

API functions to create custom GUI applications, the xPC Target
environment provides a number of API demos and scripts in the
C:\matlabroot\toolbox\rtw\targets\xpc\api directory. This topic briefly
describes those demos and scripts.

The Microsoft Visual Basic .NET 2003 demo illustrates how to create a custom
GUI that connects to a target PC with a downloaded target application. The
solution file for this demo is located in

C:\matlabroot\toolbox\rtw\targets\xpc\api\VBNET\SigsAndParamsDemo

¢ bin — Contains the executable for the demo project and the xpcapi.dll file

® Demo.sln — Contains a solution file for the Demo project

The Demo. sln file contains all the Visual Basic .NET 2003 files to run the
windows form application. This demo is a functional application that you can
use as a template to create your own custom GUIs.

The COM API example from “Example Visual Basic GUI Using COM Objects”
on page 3-4 is a simple GUI that illustrates some basic concepts for creating a
GUI with the COM API. The Demo solution is a more advanced example that
illustrates how to create a GUI similar to the xPC Target Explorer. The Demo
solution is fully commented.
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This demo illustrates how you can use the COM API to create a GUI that

® Connects to the target PC via an RS-232 or TCP/IP connection
e Starts and stops the target application loaded on the target PC
® Retrieves and lists all the signals in the target application

® Displays the value of a selected signal

® Retrieves and lists all the parameters in the target application

¢ Change the values of the parameters

Before Starting

To use the Demo solution, you need

e A target PC running a current xPC Target kernel

¢ A host PC running the MATLAB software interface, connected to the target
PC via RS-232 or TCP/IP

® A target application loaded on the target PC

The xPC Target product ships with an executable version of the demo. If you
want to rebuild the Demo solution, of if you want to write your own custom
GUIs like this one, you need Microsoft Visual Basic .NET 2003 installed on
the host PC.

Note The xPC Target software allows you to create applications, such as
GUIs, to interact with a target PC with COM API functions. Chapter 3, “xPC
Target COM API” describes this in detail. To deploy a GUI application to
other host PC systems that do not have your licensed copy of the xPC Target
product, you need the xPC Target Embedded Option™. If you do not have the
xPC Target Embedded Option and would like to deploy your GUI application,
contact your MathWorks™ representative.

Accessing the Demo Project Solution

To access the Demo solution,
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1 Copy the contents of the VBNET directory to a writable directory of your
choice.

2 Change directory to the one that contains your copy of the Demo solution.
3 Double-click demo.sln.

The Microsoft Development Environment for Visual Basic application
starts.

4 In the Solution Explorer pane, double-click Form1.vb to display the
Demo solution form.

The form is displayed. You can inspect the layout of the demo.
5 To inspect the form code, select the View menu Code option.

The Visual Basic code for the form is displayed.

Rebuilding the Demo Project Solution
To rebuild the Demo solution,

1 Double-click demo.sln.

The Microsoft Development Environment for Visual Basic application
starts.

2 Select the Build menu Build Solution option.

Using the Demo Executable

To use the Demo solution executable,

1 Change directory to the one that contains your copy of the Demo solution.
2 Change directory to the bin directory.

3 Double-click Demo1 . exe.

The GUI is displayed.
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Microsoft Visual Basic 6.0 Demo

In this section...

“Introduction” on page 4-5
“Before Starting” on page 4-6
“Accessing the sf_car_xpc Project” on page 4-6

“Rebuilding the sf car_xpc Project” on page 4-7

“Using the sf_car_xpc Executable” on page 4-7

Introduction

The Microsoft Visual Basic 6.0 sf_car_xpc demo illustrates how to create a
custom GUI that connects to a target PC. The files for this demo are located in

C:\matlabroot\toolbox\rtw\targets\xpc\api\VisualBasic\Models\sf_car_xpc

This application interfaces with the xPC Target application sf_car_xpc.dlm,
built from the Simulink model sf_car_xpc.mdl. This model simulates an
automatic transmission control system composed of modules that represent
the engine, transmission, and vehicle, with an additional logic block to control
the transmission ratio. User inputs to the model are in the form of throttle
(%) and brake torque (ft-1b).

This demo illustrates how you can use the COM API to create a GUI that

® Connects to the target PC via an RS-232 or TCP/IP connection

® Loads the sf_car_xpc.dlm target application to the target PC

® Starts and starts the target application engine

e Edits the stop time of the target application

¢ Edits the sample time of the target application

¢ Displays the speed, RPM, and gear of the target application engine
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Note For detailed information on the project, see the readme. txt file located
in C:\matlabroot\toolbox\rtw\targets\xpc\api\VisualBasic\Models\
sf_car_xpc.

Before Starting
To use the sf_car_xpc project, you need

e A target PC running a current xPC Target kernel

¢ A host PC running the MATLABinterface, connected to the target PC via
RS-232 or TCP/IP

The xPC Target product ships with an executable version of the sf_car_xpc
project. If you want to rebuild the sf_car_xpc project, you need Microsoft
Visual Basic 6.0 Professional installed on the host PC. If you want to view
or edit the model, you need to have the Stateflow® product installed on the
host PC.

Note The xPC Target environment allows you to create applications, such as
GUIs, to interact with a target PC with COM API functions. Chapter 3, “xPC
Target COM API” describes this in detail. To deploy a GUI application to
other host PC systems that do not have your licensed copy of the xPC Target
product, you need the xPC Target Embedded Option license. If you do not
have the xPC Target Embedded Option license and would like to deploy your
GUI application, contact your MATLAB representative.

Accessing the sf_car_xpc Project
To access the sf_car_xpc project,

1 Copy the contents of the VisualBasic directory to a writable directory of
your choice.

2 Change directory to the one that contains your copy of the sf_car_xpc
project.
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3 Double-click the Visual Basic project. For example, double-click
sf_car_xpc_COM. vbp.

The Microsoft Visual Basic application starts.
4 In the right Project pane, expand the Forms folder.
5 Double-click the form you want to look at.
The form is displayed. You can inspect the layout of it.
6 To inspect the form code, select the View menu Code option.

The Visual Basic code for the form is displayed.

Rebuilding the sf car_xpc Project

To rebuild the sf_car_xpc project,

1 Double-click the Visual Basic project. For example, double-click
sf_car_xpc_COM. vbp.

The Microsoft Visual Basic application starts.

2 Select the File menu Make sf_car_xpc.exe.

Using the sf car_xpc Executable
To use the sf_car_xpc project executable,

1 Change directory to the one that contains your copy of the sf_car_xpc
project.

2 Change directory to the bin directory.
3 Double-click sf_car_xpc.exe.

The GUI is displayed.
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Tcl/Tk Scripts

In this section...

“Introduction” on page 4-8

“Required Tcl/Tk Software” on page 4-9

“Using the Demo Scripts” on page 4-9

Introduction

The Tcl/Tk demos are scripts that illustrate how to directly access xPC Target
COM API functions through a command-line interpreter like Tcl/Tk. With
Tel/Tk

® You can write simple command-line scripts that communicate with a target

PC and the target application downloaded on that target PC.

® You can write simple GUIs that you can use to interact with a target

application downloaded on a target PC.

The files for this scripts are located in

C:

\matlabroot\toolbox\rtw\targets\xpc\api\tcltk

xpcapi.dll — The xPC Target API DLL file. This file must be in the
current (pwd) directory. Alternatively, you can copy the file xpcapi.dll
into the Windows system directory.

xpcbase.tcl — Contains utility procedures used by the other scripts in
the series

xpclists.tcl — Generates a list of signals or parameters for the target
application currently loaded on the target PC

xpcload.tcl — Loads the specified target application to the connected
target PC

xpcoutputlog.tcl — Reads log data from the target PC and plots the
data on the host PC

xpcstart.tcl — Starts the target application loaded on the target PC



Tel/Tk Scripts

e xpcstop.tcl — Stops the target application loaded on the target PC

® xpctargetping.tcl — Tests the communication between the host and
target PCs

® xpctargetscope.tcl — Creates a simple GUI that enables you to add
and control a scope of type target

e xpctune.tcl — Creates a simple GUI slider that enables you to manipulate
a parameter value for the target PC application

Required Tcl/Tk Software

To use these Tcl/Tk scripts, or to write your own Tcl/Tk scripts, you need

e An installation of a Tecl/Tk distribution on the host PC.

® An add-on package to the Tcl/Tk interpreter so that the scripts can
access the COM API objects. The tcom package is recommended.
This package was used to create the demo scripts in the
C:\matlabroot\toolbox\rtw\targets\tcltk directory.

® The math::statistics package. This package is required for the
xpcoutputlog.tcl file.

Note There are Tcl/Tk distributions that include required and useful
packages for use with the xPC Target software. For example, the Tcl/Tk
distribution at http://www.activestate.com contains these packages.

Using the Demo Scripts

The top of each Tcl/Tk script file contains directions on how to use each Tcl/Tk
scripts. In general:

1 Copy the contents of the tcltk directory to a writable directory of your
choice.

2 Change directory to the one that contains your copy of the Tcl/Tk script files.
3 Start your Tcl/Tk interpreter.

4 Load the Tcl/Tk script with the source command. For example,


http://www.activestate.com

4 .rc Target™ COM API Demos and Scripts

source xpctargetping.tcl

5 Run the loaded script. For example,

xpctargetping 192.168.0.10 22222

The selected script executes. In this example, xpctargetping.tcl tests
the communication between the host and target PC and returns a success
or failure message.
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API Function and Method
Reference

C API Functions (p. 5-2) Program with C API functions
COM API Methods (p. 5-11) Program with COM API methods



5 AP| Function and Method Reference

C API Functions

Logging, Scope, and File System Data structures for data logging and

Structures (p. 5-2) scopes

Communications Functions (p. 5-3) Communicate between host and
target PCs

Target Application Functions (p. 5-3) Manipulate target applications

Data Logging Functions (p. 5-5) Log data

Scope Functions (p. 5-5) Manipulate scopes

File System Functions (p. 5-7) Manipulate file systems

Target Scope Functions (p. 5-8) Manipulate scopes of type target

Monitoring and Tuning Functions Monitor and tune parameters and

(p. 5-9) signals

Miscellaneous Functions (p. 5-9) Manipulate miscellaneous xPC

Target components

Logging, Scope, and File System Structures

dirStruct Type definition for file system
directory information structure

diskinfo Type definition for file system disk
information structure

fileinfo Type definition for file information
structure

Igmode Type definition for logging options
structure

scopedata Type definition for scope data
structure



C API Functions

Communications Functions

xPCCloseConnection
xPCClosePort

xPCDeRegisterTarget

xPCGetLoadTimeOut
xPCOpenConnection
xPCOpenSerialPort
xPCOpenTcplpPort

xPCReboot
xPCRegisterTarget

xPCReOpenPort
xPCSetLoadTimeOut

xPCTargetPing

Close RS-232 or TCP/IP
communication connection

Close RS-232 or TCP/IP
communication connection

Delete target communication
properties from xPC Target API
library

Return timeout value for
communication between host
PC and target PC

Open connection to target PC

Open RS-232 connection to xPC
Target system

Open TCP/IP connection to xPC
Target system

Reboot target PC

Register target with xPC Target API
library

Reopen communication channel

Change initialization timeout value
between host PC and target PC

Ping target PC

Target Application Functions

xPCAverageTET
xPCGetAPIVersion

xPCGetAppName

Return average task execution time

Get version number of xPC Target
API

Return target application name
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xPCGetExecTime

xPCGetSampleTime

xPCGetSessionTime

xPCGetStopTime
xPCGetTargetVersion
xPCIsAppRunning

xPCIsOverloaded
xPCLoadApp

xPCLoadParamSet
xPCMaximumTET

xPCMinimumTET

xPCSaveParamSet

xPCSetSampleTime

xPCSetStopTime
xPCStartApp
xPCStopApp
xPCUnloadApp

Return target application execution
time

Return target application sample
time

Return length of time xPC Target
kernel has been running

Return stop time
Get xPC Target kernel version

Return target application running
status

Return target PC overload status

Load target application onto target
PC

Restore parameter values

Copy maximum task execution time
to array

Copy minimum task execution time
to array

Save parameter values of target
application

Change target application sample
time

Change target application stop time
Start target application

Stop target application

Unload target application



C API Functions

Data Logging Functions

xPCGetLogMode

xPCGetNumOutputs
xPCGetNumStates
xPCGetOutputLog
xPCGetStatelLog
xPCGetTETLog
xPCGetTimelLog
xPCMaxLogSamples

xPCNumLogSamples
xPCNumLogWraps

xPCSetLogMode

Scope Functions

xPCAddScope
xPCGetNumScopes

xPCGetNumScSignals

xPCGetScope
xPCGetScopeList
xPCGetScopes
xPClIsScFinished

Return logging mode and increment
value for target application

Return number of outputs
Return number of states
Copy output log data to array
Copy state log values to array
Copy TET log to array

Copy time log to array

Return maximum number of samples
that can be in log buffer

Return number of samples in log
buffer

Return number of times log buffer
wraps

Set logging mode and increment
value of scope

Create new scope

Return number of scopes added to
target application

Returns number of signals added to
specific scope

Get and copy scope data to structure
Get and copy list of scope numbers
Get and copy list of scope numbers

Return data acquisition status for
scope



5 AP| Function and Method Reference

xPCRemScope
xPCScAddSignal
xPCScGetData
xPCScGetDecimation
xPCScGetNumPrePostSamples

xPCScGetNumSamples

xPCScGetNumSignals
xPCScGetSignallList
xPCScGetSignals
xPCScGetStartTime

xPCScGetState
xPCScGetTriggerLevel
xPCScGetTriggerMode
xPCScGetTriggerScope
xPCScGetTriggerScopeSample

xPCScGetTriggerSignal
xPCScGetTriggerSlope
xPCScGetType
xPCScRemSignal
xPCScSetDecimation
xPCScSetNumPrePostSamples

xPCScSetNumSamples

xPCScSetTriggerLevel

Remove scope

Add signal to scope

Copy scope data to array
Return decimation of scope

Get number of pre- or posttriggering
samples before triggering scope

Get number of samples in one data
acquisition cycle

Get number of signals in scope
Copy list of signals to array
Copy list of signals to array

Get start time for last data
acquisition cycle

Get state of scope
Get trigger level for scope
Get trigger mode for scope
Get trigger scope

Get sample number for triggering
scope

Get trigger signal for scope
Get trigger slope for scope
Get type of scope

Remove signal from scope
Set decimation of scope

Set number of pre- or posttriggering
samples before triggering scope

Set number of samples in one data
acquisition cycle

Set trigger level for scope



C API Functions

xPCScSetTriggerMode Set trigger mode of scope
xPCScSetTriggerScope Select scope to trigger another scope
xPCScSetTriggerScopeSample Set sample number for triggering
scope
xPCScSetTriggerSignal Select signal to trigger scope
xPCScSetTriggerSlope Set slope of signal that triggers scope
xPCScSoftwareTrigger Set software trigger of scope
xPCScStart Start data acquisition for scope
xPCScStop Stop data acquisition for scope
xPCSetScope Set properties of scope

File System Functions

xPCFSCD Change current directory on target
PC to specified path

xPCFSCloseFile Close file on target PC

xPCFSDir Get contents of specified directory on
target PC

xPCFSDirltems Get contents of specified directory on
target PC

xPCFSDirSize Return size of specified directory on
target PC

xPCFSDirStructSize Get number of items in directory

xPCFSDiskInfo Information about target PC file
system

xPCFSFilelnfo Return information for open file on
target PC

xPCFSGetError Get text description for error number
on target PC file system

xPCFSGetFileSize Return size of file on target PC
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xPCFSGetPWD
xPCFSOpenkFile
xPCFSReadFile
xPCFSRemovekFile
xPCFSRMDIR
xPCFSScGetFilename
xPCFSScGetWriteMode
xPCFSScGetWriteSize
xPCFSScSetFilename

xPCFSScSetWriteMode

xPCFSScSetWriteSize

xPCFSWriteFile

Target Scope Functions

xPCTgScGetGrid

xPCTgScGetMode

xPCTgScGetViewMode
xPCTgScGetYLimits
xPCTgScSetGrid
xPCTgScSetMode
xPCTgScSetViewMode
xPCTgScSetYLimits

Get current directory of target PC
Open file on target PC

Read open file on target PC
Remove file from target PC
Remove directory from target PC
Get name of file for scope

Get write mode of file for scope
Get block write size of data chunks

Specify name for file to contain
signal data

Specify when file allocation table
entry is updated

Specify that memory buffer collect
data in multiples of write size

Write to file on target PC

Get status of grid line for particular
scope

Get scope mode for displaying
signals

Get view mode for target PC display
Copy y-axis limits for scope to array
Set grid mode for scope

Set display mode for scope

Set view mode for scope

Set y-axis limits for scope



C API Functions

Monitoring and Tuning Functions

xPCGetNumParams

xPCGetNumSignals
xPCGetParam

xPCGetParamDims

xPCGetParamldx
xPCGetParamName
xPCGetSigldxfromLabel
xPCGetSigLabelWidth
xPCGetSignal
xPCGetSignalldx
xPCGetSignalName

xPCGetSignals
xPCGetSignalWidth
xPCSetParam

Miscellaneous Functions

xPCErrorMsg

xPCFreeAPI
xPCGetEcho

xPCGetLastError
xPCInitAPI

Return number of tunable
parameters

Return number of signals

Get parameter value and copy it to
array

Get row and column dimensions of
parameter

Return parameter index

Get name of parameter

Return array of signal indices
Return number of elements in signal
Return value of signal

Return index for signal

Copy name of signal to character
array

Return vector of signal values
Return width of signal

Change value of parameter

Return text description for error
message

Unload xPC Target DLL

Return display mode for target
message window

Return constant of last error

Initialize xPC Target DLL
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xPCSetEcho Turn message display on or off
xPCSetLastError Set last error to specific string
constant

5-10



COM APl Methods

COM API Methods

Communication Objects
(xPCProtocol) (p. 5-11)

Scope Objects (xPCScopes) (p. 5-12)
Target Objects (xPCTarget) (p. 5-14)

File System Objects (xPCFileSystem)
(p. 5-16)

Work with COM API communication
objects

Work with COM API scope objects
Work with COM API Target objects

Work with COM API file system
objects

Communication Objects (xPCProtocol)

xPCProtocol.Close

xPCProtocol.GetLoadTimeOut

xPCProtocol.GetxPCErrorMsg
xPCProtocol.Init
xPCProtocol.isxPCError
xPCProtocol.Port

xPCProtocol.Reboot
xPCProtocol.RS232Connect
xPCProtocol.SetLoadTimeOut
xPCProtocol.TargetPing
xPCProtocol. TepIpConnect

xPCProtocol.Term

Close RS-232 or TCP/IP
communication connection

Return current timeout value for
target application initialization

Return error string
Initialize xPC Target API DLL
Return error status

Contain communication channel
index

Reboot target PC

Open RS-232 connection to target PC
Change initialization timeout value
Ping target PC

Open TCP/IP connection to target
PC

Unload xPC Target API DLL from
memory
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Scope Objects (xPCScopes)

xPCScopes.AddFileScope
xPCScopes.AddHostScope
xPCScopes.AddTargetScope
xPCScopes.GetScopes
xPCScopes.GetxPCError
xPCScopes.Init

xPCScopes.IsScopeFinished
xPCScopes.isxPCError
xPCScopes.RemScope
xPCScopes.ScopeAddSignal
xPCScopes.ScopeGetData
xPCScopes.ScopeGetDecimation

xPCScopes.ScopeGetNumPrePost-
Samples

xPCScopes.ScopeGetNumSamples

xPCScopes.ScopeGetSignals
xPCScopes.ScopeGetStartTime

xPCScopes.ScopeGetState
xPCScopes.ScopeGetTriggerLevel
xPCScopes.ScopeGetTriggerMode
xPCScopes.ScopeGetTriggerModeStr
xPCScopes.ScopeGetTriggerSample

xPCScopes.ScopeGetTriggerSignal

Create new scope of type file
Create new scope of type host
Create new scope of type target
Get and copy list of scope numbers
Get error string

Initialize scope object to
communicate with target PC

Get data acquisition status for scope
Get error status

Remove scope

Add signal to scope

Copy scope data to array

Get decimation of scope

Get number of pre- or posttriggering
samples before triggering scope

Get number of samples in one data
acquisition cycle

Get list of signals

Get last data acquisition cycle start
time

Get state of scope

Get trigger level for scope
Get trigger mode for scope
Get trigger mode as string

Get sample number for triggering
scope

Get trigger signal for scope
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xPCScopes.ScopeGetTriggerSlope

xPCScopes.ScopeGetTriggerSlope-
Str

xPCScopes.ScopeGetType
xPCScopes.ScopeRemSignal
xPCScopes.ScopeSetDecimation

xPCScopes.ScopeSetNumPrePost-
Samples

xPCScopes.ScopeSetNumSamples

xPCScopes.ScopeSetTriggerLevel
xPCScopes.ScopeSetTriggerMode
xPCScopes.ScopeSetTriggerSample

xPCScopes.ScopeSetTriggerSignal
xPCScopes.ScopeSetTriggerSlope
xPCScopes.ScopeSoftwareTrigger
xPCScopes.ScopeStart
xPCScopes.ScopeStop
xPCScopes.TargetScopeGetGrid

xPCScopes.TargetScopeGetMode

xPCScopes.TargetScopeGetModeStr

xPCScopes.TargetScopeGetViewMode
xPCScopes.TargetScopeGetYLimits
xPCScopes.TargetScopeSetGrid
xPCScopes.TargetScopeSetMode

Get trigger slope for scope
Get trigger slope as string

Get type of scope
Remove signal from scope
Set decimation of scope

Set number of pre- or posttriggering
samples before triggering scope

Set number of samples in one data
acquisition cycle

Set trigger level for scope
Set trigger mode of scope

Set sample number for triggering
scope

Select signal to trigger scope

Set slope of signal that triggers scope
Set software trigger of scope

Start data acquisition for scope

Stop data acquisition for scope

Get status of grid line for particular
scope

Get scope mode for displaying
signals

Get scope mode string for displaying
signals

Get view mode for target PC display
Get y-axis limits for scope
Set grid mode for scope

Set display mode for scope
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xPCScopes.TargetScopeSetViewMode Set view mode for scope

xPCScopes.TargetScopeSetYLimits

Target Objects (xPCTarget)

xPCTarget.AverageTET
xPCTarget.GetAppName
xPCTarget.GetExecTime

xPCTarget.GetNumOQOutputs
xPCTarget.GetNumParams
xPCTarget.GetNumSignals
xPCTarget.GetNumStates
xPCTarget.GetOutputLog
xPCTarget.GetParam
xPCTarget.GetParamDims

xPCTarget.GetParamIdx
xPCTarget.GetParamName
xPCTarget.GetSampleTime
xPCTarget.GetSignal
xPCTarget.GetSignalidsfromLabel
xPCTarget.GetSignalldx
xPCTarget.GetSignalLabel
xPCTarget.GetSignalName
xPCTarget.GetSignalWidth
xPCTarget.GetStateLog
xPCTarget.GetStopTime

Set y-axis limits for scope

Get average task execution time
Get target application name

Get execution time for target
application

Get number of outputs

Get number of tunable parameters
Get number of signals

Get number of states

Copy output log data to array

Get parameter values

Get row and column dimensions of
parameter

Get parameter index

Get parameter name

Get sample time

Get signal value

Get signal IDs from signal label
Get signal index

Get signal label

Copy signal name to character array
Get width of signal

Get state log

Get stop time
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xPCTarget.GetTETLog
xPCTarget.GetTimeLog
xPCTarget.GetxPCError
xPCTarget.Init

xPCTarget.IsAppRunning

xPCTarget.IsOverloaded
xPCTarget.isxPCError
xPCTarget.LoadApp

xPCTarget.MaximumTET

xPCTarget.MaxLogSamples

xPCTarget.MinimumTET

xPCTarget.NumLogSamples

xPCTarget.NumLogWraps

xPCTarget.SetParam
xPCTarget.SetSampleTime

xPCTarget.SetStopTime

xPCTarget.StartApp
xPCTarget.StopApp
xPCTarget.UnLoadApp

Get TET log
Get time log
Get error string

Initialize target object to
communicate with target PC

Return running status for target
application

Return overload status for target PC
Return error status

Load target application onto target
PC

Copy maximum task execution time
to array

Return maximum number of samples
that can be in log buffer

Copy minimum task execution time
to array

Return number of samples in log
buffer

Return number of times log buffer
wraps

Change parameter value

Change sample time for target
application

Change stop time of target
application

Start target application
Stop target application
Unload target application
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File System Objects (xPCFileSystem)

FSDir

FSDiskInfo

xPCFileSystem.CD

xPCFileSystem.CloseFile
xPCFileSystem.DirList

xPCFileSystem.GetDiskInfo
xPCFileSystem.GetFileSize
xPCFileSystem.Init

xPCFileSystem.MKDIR
xPCFileSystem.OpenFile
xPCFileSystem.PWD
xPCFileSystem.ReadFile
xPCFileSystem.RemoveFile
xPCFileSystem.RMDIR
xPCFileSystem.ScGetFileName
xPCFileSystem.ScGetWriteMode
xPCFileSystem.ScGetWriteSize
xPCFileSystem.ScSetFileName

xPCFileSystem.ScSetWriteMode

Type definition for file system
directory information structure

Type definition for file system disk
information structure

Change current directory on target
PC to specified path

Close file on target PC

Return contents of target PC
directory

Return disk information
Return size of file on target PC

Initialize file system object to
communicate with target PC

Create directory on target PC
Open file on target PC

Get current directory of target PC
Read open file on target PC
Remove file from target PC
Remove directory from target PC
Get name of file for scope

Get write mode of file for scope
Get block write size of data chunks

Specify file name to contain signal
data

Specify when file allocation table
entry is updated
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xPCFileSystem.ScSetWriteSize Specify that memory buffer collect
data in multiples of write size
xPCFileSystem.WriteFile Write to file on target PC
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API Functions and Methods




dirStruct

Purpose Type definition for file system directory information structure

Prototype typedef
char
char
char
int
int
int
int
int

struct {
Name[8];
Ext[3];
Day;

Month;

Year;

Hour;

Min;

isDir;

unsigned long Size;
} dirStruct;

Arguments Name

Ext

Day
Month
Year
Hour

Min

6-2

This value contains the name of the file or
directory.

This value contains the file type of the
element, if the element is a file (isDir 1s 0).
If the element is a directory (isDir is 1), this
field is empty.

This value contains the day the file or
directory was last modified.

This value contains the month the file or
directory was last modified.

This value contains the year the file or
directory was last modified.

This value contains the hour the file or
directory was last modified.

This value contains the minute the file or
directory was last modified.
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isDir This value indicates if the element is a file
(0) or directory (1). If it is a directory, Bytes
has a value of 0.

Size This value contains the size of the file in
bytes. If the element is a directory, this value
is 0.
Description The dirStruct structure contains information for a directory in the
file system.
See Also API function xPCFSDirItems
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Purpose

Prototype

Arguments

Type definition for file system disk information structure

typedef struct {

char Label[12];

char DrivelLetter;

char Reserved[3];

unsigned int SerialNumber;

unsigned int FirstPhysicalSector;

unsigned int FATType;

unsigned int FATCount;

unsigned int MaxDirEntries;

unsigned int BytesPerSector;

unsigned int SectorsPerCluster;

unsigned int TotalClusters;

unsigned int BadClusters;

unsigned int FreeClusters;

unsigned int Files;

unsigned int FileChains;

unsigned int FreeChains;

unsigned int LargestFreeChain;
} diskinfo;

Label This value contains the zero-terminated
string that contains the volume label. The
string is empty if the volume has no label.

Driveletter This value contains the drive letter, in
uppercase.

Reserved Reserved.

SerialNumber This value contains the volume serial
number.

FirstPhysicalSector This value contains the logical block

addressing (LBA) address of the logical drive
boot record. For 3.5-inch disks, this value is 0.
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FATType

FATCount

MaxDirEntries

BytesPerSector

SectorsPerCluster

TotalClusters

BadClusters

FreeClusters

Files

FileChains

This value contains the type of file system
found. It can contain 12, 16, or 32 for
FAT-12, FAT-16, or FAT-32 volumes,
respectively.

This value contains the number of FAT
partitions on the volume.

This value contains the size of the root
directory. For FAT-32 systems, this value
is 0.

This value contains the sector size. This
value is most likely to be 512.

This value contains, in sectors, the size of the
smallest unit of storage that can be allocated
to a file.

This value contains the number of file storage
clusters on the volume.

This value contains the number of clusters
that have been marked as bad. These clusters
are unavailable for file storage.

This value contains the number of clusters
that are currently available for storage.

This value contains the number of files,
including directories, on the volume. This
number excludes the root directory and files
that have an allocated file size of 0.

This value contains the number of contiguous
cluster chains. On a completely unfragmented
volume, this value is identical to the value
of Files.
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FreeChains This value contains the number of contiguous
cluster chains of free clusters. On a
completely unfragmented volume, this value
is 1.

LargestFreeChain This value contains the maximum allocated
file size, in number of clusters, for a newly
allocated contiguous file. On a completely
unfragmented volume, this value is identical
to FreeClusters.

Description The diskinfo structure contains information for file system disks.

See Also API function xPCFSDiskInfo
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Purpose Type definition for file information structure
Prototype typedef struct {
int FilePos;
int AllocatedSize;
int ClusterChains;
int VolumeSerialNumber;
char FullName[255];
}fileinfo;
Arguments FilePos This value contains the current file pointer.
AllocatedSize This value contains the currently allocated
file size.
ClusterChains This value indicates how many separate

cluster chains are allocated for the file.

VolumeSerialNumber This value holds the serial number of the
volume the file resides on.

FullName This value contains a copy of the complete
path name of the file. This field is valid only
while the file is open.

Description The fileinfo structure contains information for files in the file system.

See Also XPCFSFileInfo



FSDir
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Purpose Type definition for file system directory information structure

Prototype typedef struct {
BSTR Name;
BSTR Date;
BSTR Time;
long Bytes;
long isdir;
} FSDir;

Arguments Name This value contains the name of the file or
directory.

Date This value contains the date the file or
directory was last modified.

Time This value contains the time the file or
directory was last modified.

Bytes This value contains the size of the file in
bytes. If the element is a directory, this value
is 0.

isdir This value indicates if the element is a file

(0) or directory (1). If it is a directory, Bytes
has a value of 0.

Description The FSDir structure contains information for a directory in the file
system.
See Also API methodxPCFileSystem.DirList
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Purpose

Prototpye

Arguments

Type definition for file system disk information structure

typedef
BSTR
BSTR
BSTR
long
long
long
long
long
long
long
long
long
long
long
long
long
long

struct {

Label;
DrivelLetter;
Reserved;
SerialNumber;
FirstPhysicalSector;
FATType;

FATCount;
MaxDireEntries;
BytesPerSector;
SectorsPerCluster;
TotalClusters;
BadClusters;
FreeClusters;
Files;

FileChains;
FreeChains;
LargestFreeChain;

} FSDiskInfo;

Label This value contains the zero-terminated
string that contains the volume label. The
string is empty if the volume has no label.

Driveletter This value contains the drive letter, in
uppercase.

Reserved Reserved.

SerialNumber This value contains the volume serial
number.

FirstPhysicalSector This value contains the logical block address

(LBA) of the logical drive boot record. For
3.5-inch disks, this value is 0.
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FATType

FATCount

MaxDirEntries

BytesPerSector

SectorsPerCluster

TotalClusters

BadClusters

FreeClusters

Files

FileChains

This value contains the type of file system
found. It can contain 12, 16 , or 32 for
FAT-12, FAT-16, or FAT-32 volumes,
respectively.

This value contains the number of FAT
partitions on the volume.

This value contains the size of the root
directory. For FAT-32 systems, this value
is 0.

This value contains the sector size. This
value is most likely to be 512.

This value contains, in sectors, the size of the
smallest unit of storage that can be allocated
to a file.

This value contains the number of file storage
clusters on the volume.

This value contains the number of clusters
that have been marked as bad. These clusters
are unavailable for file storage.

This value contains the number of clusters
that are currently available for storage.

This value contains the number of files,
including directories, on the volume. This
number excludes the root directory and files
that have an allocated file size of 0.

This value contains the number of contiguous
cluster chains. On a completely unfragmented
volume, this value is identical to the value

of Files.
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FreeChains This value contains the number of contiguous
cluster chains of free clusters. On a
completely unfragmented volume, this value
is 1.

LargestFreeChain This value contains the maximum allocated
file size, in number of clusters, for a newly
allocated contiguous file. On a completely
unfragmented volume, this value is identical
to FreeClusters.

Description The FSDiskInfo structure contains information for file system disks.

See Also API method xPCFileSystem.GetDiskInfo
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Igmode

Purpose

Prototype

Arguments

Description

See Also

6-12

Type definition for logging options structure

typedef struct {

double incrementvalue;

int mode ;
} lgmode;
mode
incrementvalue

This value indicates the type of logging you want.
Specify LGMOD_TIME for time-equidistant logging.
Specify LGMOD_VALUE for value-equidistant
logging.

If you set mode to LGMOD_VALUE for
value-equidistant data, this option specifies
the increment (difference in amplitude) value
between logged data points. A data point is
logged only when an output signal or a state
changes by incrementvalue.

If you set mode to LGMOD_TIME, incrementvalue
1s ignored.

The 1gmode structure specifies data logging options. The mode variable
accepts either the numeric values O or 1 or their equivalent constants
LGMOD_TIME or LGMOD_VALUE from xpcapiconst.h.

API functions xPCSetLogMode, xPCGetLogMode



scopedata

Purpose

Prototype

Arguments

Type definition for scope data structure

typedef struct {

int
int
int
int
int
int
int
int
int
int
int
double
int

number;

type;

state;
signals[10];
numsamples;
decimation;
triggermode;
numprepostsamples;
triggersignal
triggerscope;
triggerscopesample
triggerlevel,;
triggerslope;

} scopedata;

number

type

state

)

The scope number.

Determines whether the scope is displayed
on the host computer or on the target
computer. Values are one of the following:

1
2

Host
Target

Indicates the scope state. Values are one of
the following:

0
1

2
3
4

Waiting to start

Scope is waiting for a trigger

Data is being acquired

Acquisition is finished

Scope is stopped (interrupted)
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scopedata
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signals

numsamples

decimation

triggermode

numprepostsamples

triggersignal

triggerscope

triggerscopesample

5 Scope 1s preacquiring data

List of signal indices from the target object
to display on the scope.

Number of contiguous samples captured
during the acquisition of a data package.

A number, N, meaning every Nth sample is
acquired in a scope window.

Trigger mode for a scope. Values are one of
the following:

0 FreeRun (default)
1 Software

2 Signal

3 Scope

If this value is less than 0, this is the number
of samples to be saved before a trigger event.
If this value is greater than 0, this is the
number of samples to skip after the trigger
event before data acquisition begins.

If triggermode = 2 for signal, identifies the
block output signal to use for triggering the
scope. You identify the signal with a signal
index.

If triggermode = 3 for scope, identifies the
scope to use for a trigger. A scope can be set
to trigger when another scope is triggered.

If triggermode = 3 for scope, specifies the
number of samples to be acquired by the
triggering scope before triggering a second
scope. This must be a nonnegative value.



scopedata

Description

See Also

triggerlevel If triggermode = 2 for signal, indicates the
value the signal has to cross to trigger the
scope and start acquiring data. The trigger
level can be crossed with either a rising or
falling signal.

triggerslope If triggermode = 2 for signal, indicates
whether the trigger is on a rising or falling
signal. Values are

0 Either rising or falling (default)
1 Rising
2 Falling

The scopedata structure holds the data about a scope used in the
functions xPCGetScope and xPCSetScope. In the structure, the fields
are as in the various xPCGetSc* functions (for example, state is as in
xPCScGetState, signals is as in xPCScGetSignals, etc.). The signal
vector is an array of the signal identifiers, terminated by -1.

API functions xPCSetScope, xPCGetScope, xPCScGetType,
XxPCScGetState, xPCScGetSignals, xPCScGetNumSamples,
xPCScGetDecimation, xPCScGetTriggerMode,
xPCScGetNumPrePostSamples, xPCScGetTriggerSignal
XxPCScGetTriggerScope, xPCScGetTriggerLevel,
xPCScGetTriggerSlope
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xPCAddScope

Purpose Create new scope
Protol'ype void xPCAddScope(int port, int scType, int scNum);
Arguments port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.
scType Enter the type of scope.
scNum Enter a number for a new scope. Values are 1, 2, 3. . .
Description The xPCAddScope function creates a new scope on the target PC. For
scType, scopes can be of type host or target, depending on the value of
scType:

e SCTYPE_HOST for type host

® SCTYPE_TARGET for type target

e SCTYPE_FILE for type file

Constants for scType are defined in the header file xpcapiconst.h as
SCTYPE_HOST, SCTYPE_TARGET, and SCTYPE_FILE

Calling the xPCAddScope function with scNum having the number of
an existing scope produces an error. Use xPCGetScopes to find the
numbers of existing scopes.

See Also API functions xPCScAddSignal, xPCScRemSignal, xPCRemScope,
xPCSetScope, xPCGetScope, xPCGetScopes

Target object method addscope
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xPCAverageTET

Purpose

Prototype

Arguments

Return

Description

See Also

Return average task execution time
double xPCAverageTET(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCAverageTET function returns the average task execution time
(TET) for the target application.

The xPCAverageTET function returns the TET for the target application.
You can use this function when the target application is running or

when it 1s stopped.

API functions xPCMaximumTET, XPCMinimumTET

Target object property AvgTET
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xPCCloseConnection
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Purpose

Prototype

Arguments

Description

See Also

Close RS-232 or TCP/IP communication connection

void xPCCloseConnection(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCCloseConnection function closes the RS-232 or

TCP/IP communication channel opened by xPCOpenSerialPort,
xPCOpenTcpIpPort, or xPCOpenConnection. Unlike xPCClosePort,
it preserves the connection information such that a subsequent
call to xPCOpenConnection succeeds without the need to
resupply communication data such as the IP address or port
number. To completely close the communication channel, call
xPCDeRegisterTarget. Calling the xPCCloseConnection function
followed by calling xPCDeRegisterTarget is equivalent to calling
xPCClosePort.

API functions xPCOpenConnection, xPCOpenSerialPort,
xPCOpenTcpIpPort, xPCReOpenPort, xPCRegisterTarget,
xPCDeRegisterTarget



xPCClosePort

Purpose

Prototype

Arguments

Description

See Also

Close RS-232 or TCP/IP communication connection

void xPCClosePort(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCClosePort function closes the RS-232 or TCP/IP communication
channel opened by either xPCOpenSerialPort or by xPCOpenTcpIpPort.
Calling this function is equivalent to calling xPCCloseConnection and
xPCDeRegisterTarget.

API functions xPCOpenSerialPort, xPCOpenTcpIpPort, xPCReOpenPort,
xPCOpenConnection, xPCCloseConnection, xPCRegisterTarget,
xPCDeRegisterTarget

Target object method close
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xPCDeRegisterTarget
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Purpose

Prototype

Arguments

Description

See Also

Delete target communication properties from xPC Target API library

void xPCDeRegisterTarget(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCDeRegisterTarget function causes the xPC Target API library
to completely “forget” about the target communication properties. It
works similarly to xPCClosePort, but does not close the connection

to the target machine. Before calling this function, you must first

call the function xPCCloseConnection to close the connection to the
target machine. The combination of calling the xPCCloseConnection
and xPCDeRegisterTarget functions has the same effect as calling
xPCClosePort.

API functions xPCRegisterTarget, xPCOpenTcpIpPort,
xPCOpenSerialPort, xPCClosePort, xPCReOpenPort,
xPCOpenConnection, xPCCloseConnection, xPCTargetPing



xPCErrorMsg

Purpose Return text description for error message
Protol'ype char *xPCErrorMsg(int error_number, char *error_message);
Arguments error_number Enter the constant of an error.

error_message The xPCErrorMsg function copies the error message
string into the buffer pointed to by error_message.
error_message is then returned. You can later use
error_message in a function such as printf.

If error_message is NULL, the xPCErrorhMsg
function returns a pointer to a statically allocated

string.
Return The xPCErrorMsg function returns a string associated with the error
error_number.
Description The xPCErrorMsg function returns error_message, which makes

it convenient to use in a printf or similar statement. Use the
xPCGetLastError function to get the constant for which you are getting
the message.

See Also API functions xPCSetLastError, xPCGetLastError
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xPCFileSystem.CD
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Purpose
Prototype

Member
of

Arguments

Return

Description

See Also

Change current directory on target PC to specified path
long CD(BSTR dir);

XPCAPICOMLib.xPCFileSystem

[in] dir Enter the path on the target PC to change to.

If there is an error, this method returns -1. Otherwise, the method
returns 0.

The xPCFileSystem.CD method changes the current directory on the
target PC to the path specified in dir. Use the xPCFileSystem.PWD
method to show the current directory of the target PC.

API method xPCFileSystem.PWD



xPCFileSystem.CloseFile

Purpose
Prototype

Member
of

Arguments

Return

Description

See Also

Close file on target PC
CloseFile(long filehandle);

XPCAPICOMLib.xPCFileSystem

[in] filehandle Enter the file handle of an open file on the
target PC.

If there is an error, this method returns -1. Otherwise, the method
returns 0.

The xPCFileSystem.CloseFile method closes the file associated
with fileHandle on the target PC. fileHandle is the handle of a file
previously opened by the xPCFileSystem.OpenFile method.

API methods xPCFileSystem.OpenFile, xPCFileSystem.ReadFile,
XPCFileSystem.WriteFile
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xPCFileSystem.DirList
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Purpose
Prototype

Member

oOf
Arguments

Description

See Also

Return contents of target PC directory
DirList(BSTR path);

XPCAPICOMLib.xPCFileSystem

[in] path Enter the path of the directory.

The xPCFileSystem.DirList method returns the contents of the target
PC directory specified by path as an array of the FSDir structure.

API structure FSDir
API method xPCFileSystem.GetDiskInfo



xPCFileSystem.GetDiskinfo

Purpose
Prototype

Member
of

Arguments

Description

See Also

Return disk information
GetDiskInfo(BSTR drivelLetter);

XPCAPICOMLib.xPCFileSystem

[in] driveLetter Enter the driver letter that contains the file
system.

The xPCFileSystem.GetDiskInfo method accepts as input the drive
specified by driveLetter and fills in the fields of the FSDiskInfo
structure.

API structure FSDiskInfo
API method xPCFileSystem.DirList
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xPCFileSystem.GefFileSize
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Purpose
Prototype

Member
of

Arguments

Return

Description

See Also

Return size of file on target PC
long GetFileSize(long filehandle);

XPCAPICOMLib.xPCFileSystem

[in] filehandle Enter the file handle of an open file on the
target PC.

This method returns the size of the specified file in bytes.

The xPCFileSystem.GetFileSize method returns the size, in bytes,
of the file associated with filehandle on the target PC. filehandle is
the handle of a file previously opened by the xPCFileSystem.OpenFile
method.

API methods xPCFileSystem.OpenFile, xPCFileSystem.ReadFile



xPCFileSystem.Init

Purpose
Prototype

Member
of

Arguments

Return

Description

Initialize file system object to communicate with target PC
long Init(IxPCProtocol* xPCProtocol);

XPCAPICOMLib.xPCFileSystem

[in] xPCProtocol Specify the communication port of the target
PC object for which the file system is to be
initialized.

If there is an error, this method returns -1. Otherwise, the
XPCFileSystem.Init method returns 0.

The xPCFileSystem.Init method initializes the file system object to
communicate with the target PC referenced by the xPCProtocol object.
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xPCFileSystem.MKDIR
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Purpose
Prototype

Member
of

Arguments

Return
Description

See Also

Create directory on target PC
long MKDIR(BSTR dirname);

XPCAPICOMLib.xPCFileSystem

[in] dirname Enter the name of the directory to create on the
target PC.

If there is an error, this method returns -1. Otherwise, the method
returns 0.

The xPCFileSystem.MKDIR method creates the directory dirname in the
current directory of the target PC.

API method xPCFileSystem.PWD



xPCFileSystem.OpenfFile

Purpose
Prototype

Member

of

Arguments

Return

Description

See Also

Open file on target PC
long OpenFile(BSTR filename, BSTR permission);

XPCAPICOMLib.xPCFileSystem

[in] filename Enter the name of the file to open on the
target PC.

[in] permission Enter the read/write permission with which
to open the file. Values are r (read) or w
(read/write).

The xPCFileSystem.OpenFile method returns the file handle for the
opened file.

The xPCFileSystem.OpenFile method opens the specified

file, filename, on the target PC. If the file does not exist, the
XxPCFileSystem.OpenFile method creates filename, then opens it. You
can open a file for read or read/write access.

API methods xPCFileSystem.CloseFile

XPCFileSystem.GetFileSize, xPCFileSystem.ReadFile,
XPCFileSystem.WriteFile
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xPCFileSystem.PWD
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Purpose
Prototype

Member
of

Return

Description

See Also

Get current directory of target PC
BSTR PWD();

XPCAPICOMLib.xPCFileSystem

This method returns the path of the current directory on the target PC.

The xPCFileSystem.PWD method places the path of the current
directory on the target PC.

API method xPCFileSystem.CD



xPCFileSystem.ReadFile

Purpose
Prototype

Member
of

Arguments

Return

Description

See Also

Read open file on target PC
VARIANT ReadFile(int fileHandle, int start, int numbytes);

XPCAPICOMLib.xPCFileSystem

[in] fileHandle Enter the file handle of an open file on the
target PC.
[in] start Enter an offset from the beginning of the file

from which this method can start to read.

[in] numbytes Enter the number of bytes this method is to
read from the file.

This method returns the results of the read operation as a VARIANT of
type Byte. If there is an error, this method returns VT_ERROR, whose
value is 10, instead.

The xPCFileSystem.ReadFile method reads an open file on the target
PC and returns the results of the read operation as a VARIANT of type
Byte. fileHandle is the file handle of a file previously opened by
XxPCFileSystem.OpenFile. You can specify that the read operation
begin at the beginning of the file (default) or at a certain offset into the
file (start). The numbytes parameter specifies how many bytes the
XxPCFileSystem.ReadFile method is to read from the file.

API methods xPCFileSystem.CloseFile,
XPCFileSystem.GetFileSize, xPCFileSystem.OpenFile,
XPCFileSystem.WriteFile
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xPCFileSystem.RemoveFile
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Purpose
Prototype

Member
of

Arguments

Return

Description

Remove file from target PC
long RemoveFile (BSTR filename);

XPCAPICOMLib.xPCFileSystem

[in] filename Enter the name of a file on the target PC.

If there is an error, this method returns -1. Otherwise, the method
returns 0.

The xPCFileSystem.RemoveFile method removes the file named
filename from the target PC file system. filename can be a relative or
absolute pathname on the target PC.



xPCFileSystem.RMDIR

Purpose
Prototype

Member
of

Arguments

Return

Description

Remove directory from target PC
long RMDIR(BSTR dirname);

XPCAPICOMLib.xPCFileSystem

[in] dirname Enter the name of a directory on the target
PC.

If there is an error, this method returns -1. Otherwise, the method
returns 0.

The xPCFileSystem.RMDIR method removes a directory named dirname
from the target PC file system. dirname can be a relative or absolute
pathname on the target PC.
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Purpose
Prototype

Member

oOf
Arguments

Return

Description

See Also

Get name of file for scope
BSTR ScGetFileName(long scNum);

XPCAPICOMLib.xPCFileSystem

[in] scNum Enter the scope number.

Returns the name of the file for the scope.

The xPCFileSystem.ScGetFileName method returns the name of the
file to which scope scNum will save signal data.

API method xPCFileSystem.ScSetFileName



xPCFileSystem.ScGetWriteMode

Purpose
Prototype

Member
of

Arguments

Return

Description

See Also

Get write mode of file for scope
long ScGetWriteMode(long scNum);

XPCAPICOMLib.xPCFileSystem

[in] scNum Enter the scope number.

This method returns the number indicating the write mode. Values are

0 Lazy mode. The FAT entry is updated only when the file is
closed and not during each file write operation. This mode
is faster, but if the system crashes before the file is closed,
the file system might not have the actual file size (the file
contents, however, will be intact).

1 Commit mode. Each file write operation simultaneously
updates the FAT entry for the file. This mode is slower, but
the file system always has the actual file size.

The xPCFileSystem.ScGetWriteMode method returns the write mode
of the file for the scope.

API method xPCFileSystem.ScSetWriteMode
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xPCFileSystem.ScGetWriteSize
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Purpose
Prototype

Member
of

Arguments

Return

Description

See Also

Get block write size of data chunks
long ScGetWriteSize(long scNum);

XPCAPICOMLib.xPCFileSystem

[in] scNum Enter the scope number.

This method returns the block size, in bytes, of the data chunks.

The xPCFileSystem.ScGetWriteSize method gets the block size, in
bytes, of the data chunks.

API method xPCFileSystem.ScSetWriteSize



xPCFileSystem.ScSetFileName

Purpose
Prototype

Member

of

Arguments

Return

Description

See Also

Specify file name to contain signal data
long ScSetFileName(long scNum, BSTR filename);

XPCAPICOMLib.xPCFileSystem

[in] scNum Enter the scope number.
[in] filename Enter the name of a file to contain the signal
data.

If there is an error, this method returns -1. Otherwise, the method
returns 0.

The xPCFileSystem.ScSetFileName method sets the name of the file
to which the scope will save the signal data. The xPC Target software
creates this file in the target PC file system. Note that you can only call
this method when the scope is stopped.

API method xPCFileSystem.ScGetFileName
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xPCFileSystem.ScSetWriteMode

Purpose Specify when file allocation table entry is updated
Protol'ype long ScSetWriteMode(long scNum, long writeMode);
Member XPCAPICOMLib.xPCFileSystem
of
Arguments [in] scNum Enter the scope number.
[in] writeMode Enter an integer for the write mode:
0 Enables lazy write mode
1 Enables commit write mode
Return If there is an error, this method returns -1. Otherwise, the method
returns 0.
Description The xPCFileSystem.ScSetWriteMode method specifies when a file

allocation table (FAT) entry is updated. Both modes write the signal
data to the file, as follows:

0 Lazy mode. The FAT entry is updated only when the file is
closed and not during each file write operation. This mode
is faster, but if the system crashes before the file is closed,
the file system might not have the actual file size (the file
contents, however, will be intact).

1 Commit mode. Each file write operation simultaneously
updates the FAT entry for the file. This mode is slower,
but the file system always has the actual file size.

See Also API method xPCFileSystem.ScSetWriteMode
Scope object property Mode
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xPCFileSystem.ScSetWriteSize

Purpose
Prototype

Member
of

Arguments

Return

Description

See Also

Specify that memory buffer collect data in multiples of write size
long ScSetWriteSize(long scNum, long writeSize);

XPCAPICOMLib.xPCFileSystem

[in] scNum Enter the scope number.
[in] writeSize Enter the block size, in bytes, of the data
chunks.

If there is an error, this method returns -1. Otherwise, the method
returns 0.

The xPCFileSystem.ScSetWriteSize method specifies that a memory
buffer collect data in multiples of writeSize. By default, this parameter
is 512 bytes, which is the typical disk sector size. Using a block size
that is the same as the disk sector size provides optimal performance.
writeSize must be a multiple of 512.

API method xPCFileSystem.ScGetWriteSize
Scope object property WriteSize

6-39



xPCFileSystem.WriteFile

Purpose

Prototype

Member
of

Arguments

Return

Description

See Also

6-40

Write to file on target PC

long WriteFile(long fileHandle, long numbytes,
VARIANT buffer);

XPCAPICOMLib.xPCFileSystem

[in] fileHandle Enter the file handle of an open file on the
target PC.
[in] numbytes Enter the number of bytes this method is

to write into the file.

[in] buffer The contents to write to fileHandle are
stored in buffer.

If there is an error, this method returns -1. Otherwise, the method
returns 0.

The xPCFileSystem.WriteFile method writes the contents of the
VARIANT buffer, of type Byte, to the file specified by fileHandle on the
target PC. The fileHandle parameter is the handle of a file previously
opened by xPCFSOpenFile. numbytes is the number of bytes to write to
the file.

API methods xPCFileSystem.CloseFile,
XPCFileSystem.GetFileSize, xPCFileSystem.OpenFile,
xPCFileSystem.ReadFile



XPCFreeAPI

Purpose
Prototype
Arguments

Description

See Also

Unload xPC Target DLL
int xPCFreeAPI(void);
none

The xPCFreeAPI function unloads the xPC Target dynamic link library.
You must execute this function once at the end of the application to
unload the xPC Target API DLL. This frees the memory allocated to the
functions. This function is defined in the file xpcinitfree.c. Link this
file with your application.

API functions xPCInitAPI, xPCNumLogWraps, xPCNumLogSamples,
xPCMaxLogSamples, xPCGetStatelLog, xPCGetTETLog, xPCSetLogMode,
xPCGetLogMode
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xPCFSCD
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Purpose

Prototype

Arguments

Description

See Also

Change current directory on target PC to specified path

void xPCFSCD(int port, char *dir);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

dir Enter the path on the target PC to change to.

The xPCFSCD function changes the current directory on the target PC to
the path specified in dir. Use the xPCFSGetPWD function to show the
current directory of the target PC.

API function xPCFSGetPWD
File object method cd



xPCFSCloseFile

Purpose Close file on target PC

Protol'ype void xPCFSCloseFile(int port, int fileHandle);

Arguments port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

fileHandle Enter the file handle of an open file on the target

PC.

Description The xPCFSCloseFile function closes the file associated with fileHandle

on the target PC. fileHandle is the handle of a file previously opened
by the xPCFSOpenFile function.

See Also API functions xPCFSOpenFile, xPCFSReadFile, xPCFSWriteFile
File object method fclose
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xPCFSDir
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Purpose

Prototype

Arguments

Description

See Also

Get contents of specified directory on target PC

void xPCFSDir(int port, const char *path, char
*data, int numbytes);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

path Enter the path on the target PC.

data The contents of the directory are stored in data, whose

allocated size is specified in numbytes.

numbytes Enter the size, in bytes, of the array data.

The xPCFSDir function copies the contents of the target PC directory
specified by path into data. The xPCFSDir function returns the listing in
the data array, which must be of size numbytes. Use the xPCFSDirSize
function to obtain the size of the directory for the numbytes parameter.

API function xPCFSDirSize
File object method dir



xPCFSDirltems

Purpose

Prototype

Arguments

Description

See Also

Get contents of specified directory on target PC

void xPCFSDirItems(int port, const char *path, dirStruct
*dirs, int numDirItems);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

path Enter the path on the target PC.

dirs Enter the structure to contain the contents of the
directory.

numDirItems Enter the number of items in the directory.

The xPCFSDirItems function copies the contents of the target PC
directory specified by path. The xPCFSDirItems function copies the
listing into the dirs structure, which must be of size numDirItems. Use
the xPCFSDirStructSize function to obtain the size of the directory
for the numDirItems parameter.

API functions xPCFSDirStructSize, dirStruct
File object method dir
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xPCFSDirSize
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Purpose

Prototype

Arguments

Return

Description

See Also

Return size of specified directory on target PC

int xPCFSDirSize(int port, const char *path);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

path Enter the directory path on the target PC.

The xPCFSDirSize function returns the size, in bytes, of the specified
directory. If there is an error, this method returns -1.

The xPCFSDirSize function returns the size, in bytes, of the buffer
needed to get the directory listing of the directory on the target PC. Use
this size as the numbytes parameter in the xPCFSDir function.

API function xPCFSDirItems
File object method dir



XPCFSDirStructSize

Purpose

Prototype

Arguments

Return

Description

See Also

Get number of items in directory
int xPCFSDirStructSize(int port, const char *path);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

path Enter the directory path on the target PC.

The xPCFSDirStructSize function returns the number of items in the
directory on the target PC. If there is an error, this method returns -1.

The xPCFSDirStructSize function returns the number of items in the
directory on the target PC. Use this size as the numDirItems parameter

in the xPCFSDirItems function.

API function xPCFSDir
File object method dir
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xPCFSDiskinfo
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Purpose

Prototype

Arguments

Description

See Also

Information about target PC file system

diskinfo xPCFSDiskInfo(int port, const char *driveletter);

port Enter the value returned by either the
function xPCOpenSerialPort or the
function xPCOpenTcpIpPort.

driveletter Enter the drive letter of the file system
for which you want information.

The xPCFSDiskInfo function returns disk information for the file
system of the specified target PC drive, driveletter. This function
returns this information in the diskinfo structure.

API structure diskinfo



xPCFSFilelnfo

Purpose

Prototype

Arguments

Description

See Also

Return information for open file on target PC
fileinfo xPCFSFileInfo(int port, int fileHandle);
port Enter the value returned by either the

function xPCOpenSerialPort or the
function xPCOpenTcpIpPort.

fileHandle Enter the file handle of an open file on
the target PC.

The xPCFSFileInfo function returns information about the specified
open file, filehandle, in a structure of type fileinfo.

Structure fileinfo
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xXPCFSGetError

Purpose Get text description for error number on target PC file system

Protol'ype void xPCFSGetError(int port, unsigned int error_number,
char *error_message);

Arguments port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

error_number Enter the constant of an error.

error_message  The string of the message associated with the
error error_number is stored in error_message.

Description The xPCFSGetError function gets the error_message associated with
error_number. This enables you to use the error message in a printf
or similar statement.
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xPCFSGetFileSize

Purpose

Prototype

Arguments

Return

Description

See Also

Return size of file on target PC

int xPCFSGetFileSize(int port, int fileHandle);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

fileHandle Enter the file handle of an open file on the target PC.

Return the size of the specified file in bytes. If there is an error, this
method returns -1.

The xPCFSGetFileSize function returns the size, in bytes, of the file
associated with fileHandle on the target PC. fileHandle is the handle
of a file previously opened by the xPCFSOpenFile function.

API functions xPCFSOpenFile, xPCFSReadFile
File object methods fopen, fread
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xPCFSGetPWD

Purpose Get current directory of target PC
Protol'ype void xPCFSGetPWD(int port, char *pwd);
Arguments port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.
pwd The path of the current directory is stored in pwd.
Description The xPCFSGetPWD function places the path of the current directory on

the target PC in pwd, which must be allocated by the caller.

See Also File object method pwd
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xPCFSMKDIR

Purpose

Prototype

Arguments

Description

See Also

Create new directory on target PC

void xPCFSMKDIR(int port, const char *dirname);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

dirname Enter the name of the directory to create on the target
PC.

The xPCFSMKDIR function creates the directory dirname in the current
directory of the target PC.

API function xPCFSGetPWD
File object method mkdir
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xPCFSOpenfFile
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Purpose

Prototype

Arguments

Return

Description

See Also

Open file on target PC

int xPCFSOpenFile(int port, const char *filename,
const char *permission);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.
filename Enter the name of the file to open on the target PC.
permission Enter the read/write permission with which to

open the file. Values are r (read) or w (read/write).

The xPCFSOpenFile function returns the file handle for the opened file.
If there is an error, this function returns -1.

The xPCFSOpenFile function opens the specified file, filename, on the
target PC. If the file does not exist, the xPCFSOpenFile function creates
filename, then opens it. You can open a file for read or read/write
access.

API functions xPCFSCloseFile, xPCFSGetFileSize, xPCFSReadFile,
XPCFSWriteFile

File object methods fclose, filetable, fopen, fread, fwrite



xPCFSReadFile

Purpose

Prototype

Arguments

Description

See Also

Read open file on target PC

void xPCFSReadFile(int port, int fileHandle, int start,
int numbytes, unsigned char *data);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

fileHandle  Enter the file handle of an open file on the target PC.

start Enter an offset from the beginning of the file from
which this function can start to read.

numbytes Enter the number of bytes this function is to read
from the file.

data The contents of the file are stored in data.

The xPCFSReadFile function reads an open file on the target PC and
places the results of the read operation in the array data. fileHandle
is the file handle of a file previously opened by xPCFSOpenFile. You
can specify that the read operation begin at the beginning of the file
(default) or at a certain offset into the file (start). The numbytes
parameter specifies how many bytes the xPCFSReadFile function is
to read from the file.

API functions xPCFSCloseFile, xPCFSGetFileSize, xPCFSOpenFile,
XPCFSWriteFile

File object methods fopen, fread
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xPCFSRemoveFile
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Purpose

Prototype

Arguments

Description

See Also

Remove file from target PC

void xPCFSRemoveFile(int port, const char *filename);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

filename Enter the name of a file on the target PC.

The xPCFSRemoveFile function removes the file named filename
from the target PC file system. filename can be a relative or absolute
pathname on the target PC.

File object method removefile



xPCFSRMDIR
|

Purpose Remove directory from target PC
Protol'ype void xPCFSRMDIR(int port, const char *dirname);
Arguments port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.
dirname Enter the name of a directory on the target PC.
Description The xPCFSRMDIR function removes a directory named dirname from the

target PC file system. dirname can be a relative or absolute pathname
on the target PC.

See Also File object method rmdir
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xPCFSScGetFilename
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Purpose

Prototype

Arguments

Return

Description

See Also

Get name of file for scope

const char *xPCFSScGetFilename(int port, int
scNum, char *filename);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

scNum Enter the scope number.

filename The name of the file for the specified scope is stored

in filename.

Returns the value of filename, the name of the file for the scope.

The xPCFSScGetFilename function returns the name of the file to which
scope scNum will save signal data. filename points to a caller-allocated
character array to which the filename is copied.

API function xPCFSScSetFilename

Scope object property Filename



xXPCFSScGetWriteMode

Purpose

Prototype

Arguments

Return

Description

See Also

Get write mode of file for scope

int xPCFSScGetWriteMode(int port, int scNum);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

scNum Enter the scope number.

Returns the number indicating the write mode. Values are

0 Lazy mode. The FAT entry is updated only when the file is
closed and not during each file write operation. This mode
1s faster, but if the system crashes before the file is closed,
the file system might not have the actual file size (the file
contents, however, will be intact).

1 Commit mode. Each file write operation simultaneously
updates the FAT entry for the file. This mode is slower, but
the file system always has the actual file size.

The xPCFSScGetWriteMode function returns the write mode of the file
for the scope.

API function xPCFSScSetWriteMode

Scope object property Mode
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xXPCFSScGetWriteSize
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Purpose

Prototype

Arguments

Return

Description

See Also

Get block write size of data chunks

unsigned int xPCFSScGetWriteSize(int port, int scNum);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

scNum Enter the scope number.

Returns the block size, in bytes, of the data chunks.

The xPCFSScGetWriteSize function gets the block size, in bytes, of
the data chunks.

API function xPCFSScSetWriteSize

Scope object property WriteSize



xPCFSScSetFilename

Purpose

Prototype

Arguments

Description

See Also

Specify name for file to contain signal data

void xPCFSScSetFilename(int port, int scNum,
const char *filename);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

scNum Enter the scope number.

filename Enter the name of a file to contain the signal data.

The xPCFSScSetFilename function sets the name of the file to which
the scope will save the signal data. The xPC Target software creates
this file in the target PC file system. Note that you can only call this
function when the scope is stopped.

API function xPCFSScGetFilename

Scope object property Filename
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XPCFSScSetWriteMode
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Purpose

Prototype

Arguments

Description

See Also

Specify when file allocation table entry is updated

void xPCFSScSetWriteMode(int port, int scNum, int writeMode);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

scNum Enter the scope number.

writeMode Enter an integer for the write mode:
0 Enables lazy write mode

1 Enables commit write mode

The xPCFSScSetWriteMode function specifies when a file allocation
table (FAT) entry is updated. Both modes write the signal data to the
file, as follows:

0 Lazy mode. The FAT entry is updated only when the file is
closed and not during each file write operation. This mode
is faster, but if the system crashes before the file is closed,
the file system might not have the actual file size (the file
contents, however, will be intact).

1 Commit mode. Each file write operation simultaneously
updates the FAT entry for the file. This mode 1s slower,
but the file system always has the actual file size.

API function xPCFSScGetWriteMode

Scope object property Mode



xPCFSScSetWriteSize

Purpose

Prototype

Arguments

Description

See Also

Specify that memory buffer collect data in multiples of write size

void xPCFSScSetWriteSize(int port, int scNum, unsigned int
writeSize);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

scNum Enter the scope number.

writeSize Enter the block size, in bytes, of the data chunks.

The xPCFSScSetWriteSize function specifies that a memory buffer
collect data in multiples of writeSize. By default, this parameter is 512
bytes, which is the typical disk sector size. Using a block size that is the
same as the disk sector size provides optimal performance. writeSize
must be a multiple of 512.

API function xPCFSScGetWriteSize

Scope object property WriteSize

6-63



xPCFSWriteFile

Purpose

Prototype

Arguments

Description

See Also
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Write to file on target PC

void xPCFSWriteFile(int port, int fileHandle, int numbytes,
const unsigned char *data);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

fileHandle Enter the file handle of an open file on the target PC.

numbytes Enter the number of bytes this function is to write
into the file.

data The contents to write to fileHandle are stored in
data.

The xPCFSWriteFile function writes the contents of the array data
to the file specified by fileHandle on the target PC. The fileHandle
parameter is the handle of a file previously opened by xPCFSOpenFile.
numbytes is the number of bytes to write to the file.

API functions xPCFSCloseFile, xPCFSGetFileSize, xPCFSOpenFile,
XPCFSReadFile



xPCGetAPIVersion

Purpose
Prototype
Arguments

Return

Description

See Also

Get version number of xPC Target API
const char *xPCGetAPIVersion(void);
none

The xPCGetApiVersion function returns a string with the version
number of the xPC Target kernel on the target PC.

The xPCGetApiVersion function returns a string with the version
number of the xPC Target kernel on the target PC. The string is a
constant string within the API DLL. Do not modify this string.

API function xPCGetTargetVersion
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xPCGetAppName

Purpose

Prototype

Arguments

Return

Description

Examples

See Also
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Return target application name

char *xPCGetAppName(int port, char *model_name);

port

model name

Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

The xPCGetAppName function copies the target
application name string into the buffer pointed to by
model name. model name is then returned. You can
later use model_name in a function such as printf.

Note that the maximum size of the buffer is 256
bytes. To ensure that you have enough space for the
application name string, allocate a buffer of size 256
bytes.

The xPCGetAppName function returns a string with the name of the
target application.

The xPCGetAppName function returns the name of the target application.
You can use the return value, model_name, in a printf or similar
statement. In case of error, the name string is unchanged.

Allocate 256 bytes for the buffer appname.

char *appname=malloc(256);
xPCGetAppName (iport,appname);
appname=realloc (appname,strlen(appname)+1);

free(appname);

API function xPCIsAppRunning

Target object property Application



xPCGetEcho

Purpose

Prototype

Arguments

Return

Return

Description

See Also

Return display mode for target message window

int xPCGetEcho(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetEcho function returns the number indicating the display
mode. Values are

1 Display is on. Messages are displayed in the message
display window on the target.

0 Display is off.

The xPCGetEcho function the display mode of the target PC using
communication channel port. If there is an error, this function returns
-1.

The xPCGetEcho function returns the display mode of the target PC
using communication channel port. Messages include the status
of downloading the target application, changes to parameters, and

changes to scope signals.

API function xPCSetEcho
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xPCGetExecTime
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Purpose

Prototype

Arguments

Return

Description

See Also

Return target application execution time

double xPCGetExecTime(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetExecTime function returns the current execution time for a
target application. If there is an error, this function returns -1.

The xPCGetExecTime function returns the current execution time for
the running target application. If the target application is stopped, the
value is the last running time when the target application was stopped.
If the target application is running, the value is the current running
time.

API functions xPCSetStopTime, xPCGetStopTime

Target object property ExecTime



xPCGetLastError

Purpose
Prototype

Return

Description

See Also

Return constant of last error
int xPCGetLastError(void);

The xPCGetLastError function returns the error constant for the last
reported error. If there is no error, this function returns 0.

The xPCGetLastError function returns the constant of the last reported
error by another API function. This value is reset every time you

call a new function. Therefore, you should check this constant value
immediately after a call to an API function. For a list of error constants
and messages, see Appendix A, “xPC Target C API Error Messages”.

API functions xPCErrorMsg, xPCSetLastError
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xPCGetLoadTimeOut
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Purpose

Prototype

Arguments

Return

Description

Return timeout value for communication between host PC and target PC

int xPCGetLoadTimeOut(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetLoadTimeOut function returns the number of seconds
allowed for the communication between the host PC and target
application. If there is an error, this function returns -1.

The xPCGetLoadTimeOut function returns the number of seconds
allowed for the communication between the host PC and the target
application. When an xPC Target API function initiates communication
between the host PC and target PC, it waits for a certain amount of
time before checking to see if the communication is complete. In the
case where communication with the target PC is not complete, the
function returns a timeout error.

For example, when you load a new target application onto the target
PC, the function xPCLoadApp waits for a certain amount of time
before checking to see if the initialization of the target application is
complete. In the case where initialization of the target application is
not complete, the function xPCLoadApp returns a timeout error. By
default, xPCLoadApp checks for the readiness of the target PC for up to
5 seconds. However, in the case of larger models or models requiring
longer initialization (for example, those with thermocouple boards),
the default of about 5 seconds might not be sufficient and a spurious
timeout is generated. Other functions that communicate with the target
PC will wait for timeOut seconds before declaring a timeout event. The
function xPCSetLoadTimeOut sets the timeout to a different number.

Use the xPCGetLoadTimeOut function if you suspect that the current
number of seconds (the timeout value) is too short. Then use the
xPCSetLoadTimeOut function to set the timeout to a higher number.



xPCGetLoadTimeOut
|

See Also API functions xPCLoadApp, xPCSetLoadTimeOut,
xPCUnloadApp

“Increasing the Time-Out Value” in the Getting Started withxPC Target
documentation.
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xPCGetlogMode
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Purpose

Prototype

Arguments

Return

Description

See Also

Return logging mode and increment value for target application

1gmode xPCGetLogMode(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetLogMode function returns the logging mode in the 1gmode
structure. If the logging mode is 1 (LGMOD_VALUE), this function also
returns an increment value in the 1gmode structure. If an error occurs,
this function returns -1.

The xPCGetLogMode function gets the logging mode and increment
value for the current target application. The increment (difference
in amplitude) value is measured between logged data points. A data
point is logged only when an output signal or a state changes by the
increment value.

API function xPCSetLogMode
API structure 1gmode



xPCGetNumOutputs

Purpose

Prototype

Arguments

Return

Description

See Also

Return number of outputs

int xPCGetNumOutputs(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetNumOutputs function returns the number of outputs in the
current target application. If there is an error, this function returns -1.

The xPCGetNumOutputs function returns the number of outputs in the
target application. The number of outputs equals the sum of the input
signal widths of all output blocks at the root level of the Simulink model.

API functions xPCGetOutputLog, xPCGetNumStates, xPCGetStatelLog
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xXPCGetNumParams
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Purpose

Prototype

Arguments

Return

Description

See Also

Return number of tunable parameters

int xPCGetNumParams(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetNumParams function returns the number of tunable
parameters in the target application. If there is an error, this function
returns -1.

The xPCGetNumParams function returns the number of tunable
parameters in the target application. Use this function to see how many
parameters you can get or modify.

API functions xPCGetParamIdx, xPCSetParam, xPCGetParam,
xPCGetParamName, xPCGetParamDims

Target object property NumParameters



xPCGetNumScopes

Purpose

Prototype

Arguments

Return

Description

Return number of scopes added to target application

int xPCGetNumScopes(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetNumScopes function returns the number of scopes that have
been added to the target application. If there is an error, this function
returns -1.

The xPCGetNumScopes function returns the number of scopes that have
been added to the target application.
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xPCGetNumScSignals

6-76

Purpose

Prototype

Arguments

Return

Description

Returns number of signals added to specific scope

int xPCGetNumScSignals(int port, int scopeld);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

scopeld Enter the ID number of the scope for which you want to
get the number of added signals.

The xPCGetNumScSignals function returns the number of signals that
have been added to the scope, scopelID. If there is an error, this function
returns -1.

The xPCGetNumScSignals function returns the number of signals that
have been added to the scope, scopelD.



xPCGetNumSignals

Purpose

Prototype

Arguments

Return

Description

See Also

Return number of signals
int xPCGetNumSignals(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetNumSignals function returns the number of signals in the
target application. If there is an error, this function returns -1.

The xPCGetNumSignals function returns the total number of signals in
the target application that can be monitored from the host. Use this
function to see how many signals you can monitor.

API functions xPCGetSignalldx, xPCGetSignal, xPCGetSignals,
xPCGetSignalName, xPCGetSignalwWidth

Target object property NumSignals
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xXPCGetNumStates
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Purpose

Prototype

Arguments

Return
Description

See Also

Return number of states

int xPCGetNumStates(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetNumStates function returns the number of states in the
target application. If there is an error, this function returns -1.

The xPCGetNumStates function returns the number of states in the
target application.

API functions xPCGetStateLog, xPCGetNumOutputs, xPCGetOutputLog
Target object property StatelLog



xPCGetOutputlog

Purpose

Prototype

Arguments

Description

Copy output log data to array

void xPCGetOutputLog(int port, int first_sample,
int num_samples,
int decimation, int output_id, double *output_data);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

first_sample Enter the index of the first sample to copy.

num_samples  Enter the number of samples to copy from the output

log.

decimation Select whether to copy all the sample values or every
Nth value.

output_id Enter an output identification number.

output_data  The log is stored in output data, whose allocation
is the responsibility of the caller.

The xPCGetOutputLog function gets the output log and copies that
log to an array. You get the data for each output signal in turn by
specifying output_id. Output IDs range from 0 to (N-1), where N is the
return value of xPCGetNumOutputs. Entering 1 for decimation copies
all values. Entering N copies every Nth value.

For first_sample, the sample indices range from 0 to (N-1), where N is
the return value of xPCNumLogSamples. Get the maximum number of
samples by calling the function xPCNumLogSamples.

Note that the target application must be stopped before you get the
number.
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xPCGetOutputlog

See Also API functions xPCNumLogWraps, xPCNumLogSamples, xPCMaxLogSamples,
XxPCGetNumOutputs, xPCGetStateLog, xPCGetTETLog, xPCGetTimeLog

Target object method getlog
Target object property OutputLog
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xPCGetParam

Purpose

Prototype

Arguments

Description

See Also

Get parameter value and copy it to array

void xPCGetParam(int port, int paramIndex,
double *paramValue);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

paramIndex Enter the index for a parameter.

paramValue The function returns a parameter value as an array
of doubles.

The xPCGetParam function returns the parameter as an array

in paramValue. paramValue must be of sufficient size to hold

the parameter. You can query the size by calling the function
xPCGetParamDims. Get the parameter index by calling the function
xPCGetParamIdx. The parameter matrix is returned as a vector, with
the conversion being done in column-major format. It is also returned
as a double, regardless of the data type of the actual parameter.

For paramIndex, values range from 0 to (N-1), where N is the return
value of xPCGetNumParams.

API functions xPCSetParam, xPCGetParamDims, xPCGetParamIdx,
xPCGetNumParams

Target object method getparamid

Target object properties ShowParameters, Parameters
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xPCGetParamDims
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Purpose

Prototype

Arguments

Description

See Also

Get row and column dimensions of parameter

void xPCGetParamDims(int port, int paramlIndex,
int *dimension);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

paramIndex Parameter index.

dimension Dimensions (row, column) of a parameter.

The xPCGetParamDims function gets the dimensions (row, column) of
a parameter with paramIndex and stores them in dimension, which
must have at least two elements.

For paramIndex, values range from 0 to (N-1), where N is the return
value of xPCGetNumParams.

API functions xPCGetParamIdx, xPCGetParamName, xPCSetParam,
xPCGetParam, xPCGetNumParams

Target object method getparamid

Target object properties ShowParameters, Parameters



xPCGetParamidx

Purpose

Prototype

Arguments

Return

Description

See Also

Return parameter index

int xPCGetParamIdx(int port, const char *blockName,
const char *paramName) ;

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

blockName Enter the full block path generated by Real-Time
Workshop.

paramName Enter the parameter name for a parameter associated

with the block.

The xPCGetParamIdx function returns the parameter index for the
parameter name. If there is an error, this function returns -1.

The xPCGetParamIdx function returns the parameter index for the
parameter name (paramName) associated with a Simulink block
(blockName). Both blockName and paramName must be identical to those
generated at target application building time. The block names should
be referenced from the file model namept.m in the generated code,
where model name is the name of the model. Note that a block can have
one or more parameters.

API functions xPCGetParamDims, xPCGetParamName, xPCGetParam
Target object method getparamid

Target object properties ShowParameters, Parameters
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xXPCGetParamName

Purpose

Prototype

Arguments

Description

See Also
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Get name of parameter

void xPCGetParamName(int port, int paramIdx,
char *blockName, char

*paramName) ;

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

paramIdx Enter a parameter index.

blockName String with the full block path generated by
Real-Time Workshop.

paramName Name of a parameter for a specific block.

The xPCGetParamName function gets the parameter name and block
name for a parameter with the index paramIdx. The block path and
name are returned and stored in b1ockName, and the parameter name
is returned and stored in paramName. You must allocate sufficient
space for both blockName and paramName. If the paramIdx is invalid,
xPCGetLastError returns nonzero, and the strings are unchanged. Get
the parameter index from the function xPCGetParamIdx.

API functions xPCGetParam, xPCGetParamDims, xPCGetParamIdx

Target object properties ShowParameters, Parameters



xPCGetSampleTime

Purpose

Prototype

Arguments

Return

Description

See Also

Return target application sample time
double xPCGetSampleTime(int port);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

The xPCGetSampleTime function returns the sample time, in seconds, of
the target application. If there is an error, this function returns -1.

The xPCGetSampleTime function returns the sample time, in seconds,
of the target application. You can get the error by using the function
xPCGetLastError.

API function xPCSetSampleTime
Target object property SampleTime
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xPCGetScope

6-86

Purpose

Prototype

Arguments

Return

Description

See Also

Get and copy scope data to structure

scopedata xPCGetScope(int port, int scNum);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

scNum Enter the scope number.

The xPCGetScope function returns a structure of type scopedata.

The xPCGetScope function gets properties of a scope with scNum and
copies the properties into a structure with type scopedata. You can
use this function in conjunction with xPCSetScope to change several
properties of a scope at one time. See scopedata for a list of properties.
Use the xPCGetScope function to get the scope number.

API functions xPCSetScope, scopedata
Target object method getscope



xPCGetScopelist
|

Purpose Get and copy list of scope numbers
Protol'ype void xPCGetScopelList(int port, int *data);
Arguments port Enter the value returned by either the function

xPCOpenSerialPort or the function xPCOpenTcpIpPort.

data List of scope numbers in an integer array (allocated by
the caller) as a list of unsorted integers.

Description The xPCGetScopelList function gets the list of scopes currently defined.
data must be of sufficient size to hold the list of scopes. You can query
the size by calling the function xPCGetNumScopes.

Note Use the xPCGetScopelList function instead of the xPCGetScopes
function. The xPCGetScopes will be obsoleted in a future release.
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xPCGetScopes

Purpose Get and copy list of scope numbers

Protol'ype void xPCGetScopes(int port, int *data);

Arguments port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

data List of scope numbers in an integer array (allocated by

the caller) as a list of unsorted integers and terminated
by -1.

Description The xPCGetScopes function gets the list of scopes currently defined.

You can use the constant MAX_SCOPES (defined in xpcapiconst.h) as
the size of data. This is currently set to 30 scopes.

Note This function will be obsoleted in a future release. Use the
xPCGetScopelList function instead.

See Also API functions xPCSetScope, xPCGetScope, xPCScGetSignals
Target object property Scopes
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xPCGetSessionTime

Purpose

Prototype

Arguments

Return

Description

Return length of time xPC Target kernel has been running

double xPCGetSessionTime(int port);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

The xPCGetSessionTime function returns the amount of time in seconds
that the xPC Target kernel has been running on the target PC. If there
is an error, this function returns -1.

The xPCGetSessionTime function returns, as a double, the amount of
time in seconds that the xPC Target kernel has been running. This
value is also the time that has elapsed since you last booted the target
PC.
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xPCGetSignal

Purpose Return value of signal
Protol'ype double xPCGetSignal(int port, int sigNum);
Arguments port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.
sigNum Enter a signal number.
Return The xPCGetSignal function returns the current value of signal sigNum.

If there is an error, this function returns -1.

Description The xPCGetSignal function returns the current value of a signal.
For vector signals, use xPCGetSignals rather than call this function
multiple times. Use the xPCGetSignalIdx function to get the signal
number.

See Also API function xPCGetSignals
Target object properties ShowSignals, Signals
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xPCGetSignalldx

Purpose

Prototype

Arguments

Return

Description

See Also

Return index for signal

int xPCGetSignalldx(int port, const char *sigName);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

sigName Enter a signal name.

The xPCGetSignalldx function returns the index for the signal with
name sigName. If there is an error, this function returns -1.

The xPCGetSignalldx function returns the index of a signal. The name
must be identical to the name generated when the application was
built. You should reference the name from the file model_namebio.min
the generated code, where model name is the name of the model. The
creator of the application should already know the signal name.

API functions xPCGetSignalName, xPCGetSignalWidth, xPCGetSignal,
xPCGetSignals

Target object method getsignalid
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xPCGetSigldxfromLabel

Purpose

Prototype

Arguments

Return

Description

See Also
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Return array of signal indices

int xPCGetSigIdxfromLabel(int port, const char
*siglabel, int *siglIds);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

siglLabel String with the name of a signal label.

siglIds Return array of signal indices.

The xPCGetSigIdxfromLabel function fills an array sigIds of signal
indices. If no signal is found, this function returns -1. It returns zero
(0) upon success.

The xPCGetSigIdxfromLabel function returns in sigIds the array of
signal indices for signal sigName. This function assumes that you have
labeled the signal for which you request the indices (see the Signal
name parameter of the “Signal Properties Dialog Box” in the Simulink
documentation). Note that the xPC Target software refers to Simulink
signal names as signal labels. The creator of the application should
already know the signal name/label.

sigIds must be large enough to contain the array of indices. You can
use the xPCGetSiglLabelWidth function to get the required amount of
memory to be allocated by the sigIds array.

API functions xPCGetSignallabel, xPCGetSigLabelWidth



xPCGetSignalLabel

Purpose

Prototype

Arguments

Return

Description

See Also

Copy label of signal to character array

char * xPCGetSignallLabel(int port, int sigldx,
char *siglabel);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

sigIdx Enter signal index.

siglLabel Return signal label associated with signal index, sigIdx.

The xPCGetSignallLabel function returns the label of the signal.

The xPCGetSignallLabel function copies and returns the signal label,
including the block path, of a signal with sigIdx. The result is stored
in siglabel. If sigIdx is invalid, xPCGetLastError returns a nonzero
value, and sigLabel is unchanged. The function returns siglLabel,
which makes it convenient to use in a printf or similar statement. This
function assumes that you already know the signal index.

This function assumes that you have labeled the signal for which you
request the index (see the Signal name parameter of the “Signal
Properties Dialog Box” in the Simulink documentation). Note that
the xPC Target software refers to Simulink signal names as signal
labels. The creator of the application should already know the signal
name/label.

API functions xPCGetSigIdxfromLabel, xPCGetSigLabelWidth
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xPCGetSigLabelWidth
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Purpose

Prototype

Arguments

Return

Description

See Also

Return number of elements in signal

int xPCGetSiglLabelWidth(int port, const char *sigName);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

sigName String with the name of a signal.

The xPCGetSigLabelWidth function returns the number of elements
that the signal sigName contains. If there is an error, this function
returns -1.

The xPCGetSiglLabelWidth function returns the number of elements
that the signal sigName contains. This function assumes that you have
labeled the signal for which you request the elements (see the Signal
name parameter of the “Signal Properties Dialog Box” in the Simulink
documentation). Note that the xPC Target software refers to Simulink
signal names as signal labels. The creator of the application should
already know the signal name/label.

API functions xPCGetSigIdxfromLabel, xPCGetSignallLabel



xPCGetSignalName

Purpose

Prototype

Arguments

Return

Description

See Also

Copy name of signal to character array

char *xPCGetSignalName(int port, int siglIdx,
char *sigName);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

sigIdx Enter a signal index.

sigName String with the name of a signal.

The xPCGetSignalName function returns the name of the signal.

The xPCGetSignalName function copies and returns the signal name,
including the block path, of a signal with sigIdx. The result is stored
in sigName. If sigIdx is invalid, xPCGetLastError returns a nonzero
value, and sigName is unchanged. The function returns sigName, which
makes it convenient to use in a printf or similar statement. This
function assumes that you already know the signal index.

API functions xPCGetSignalIdx, xPCGetSignalwidth, xPCGetSignal,
xPCGetSignals

Target object properties ShowSignals, Signals
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xPCGetSignals

Purpose

Prototype

Arguments

Return

Description

See Also

Example
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Return vector of signal values

int xPCGetSignals(int port, int numSignals,
const int *signals,
double *values);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

numSignals Enter the number of signals to be acquired (that is, the
number of values in signals).

signals Enter the list of signal numbers to be acquired.

values Returned values are stored in the double array values.

The xPCGetSignals function returns 0 upon success. If there is an
error, this function returns -1.

The xPCGetSignals function is the vector version of the function
xPCGetSignal. This function returns the values of a vector of signals
(up to 1000) as fast as it can acquire them. The signal values are not
guaranteed to be at the same time step (for that, define a scope of type
SCTYPE_HOST and use xPCScGetData). xPCGetSignal does the same
thing for a single signal, and could be used multiple times to achieve the
same effect. However, the xPCGetSignals function is faster, and the
signal values are more likely to be spaced closely together. The signals
are converted to doubles regardless of the actual data type of the signal.

For signals, the list you provide should be stored in an integer array.
Get the signal numbers with the function xPCGetSignalIdx.

API function xPCGetSignal, xPCGetSignalIdx

To reference signal vector data rather than scalar values, pass a vector
of indices for the signal data. For example:



xPCGetSignals
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/* Assume a signal of width 10, with the blockpath
* mySubsys/mySignal and the signal index si.
*/

int i;
int sigId[10];
double sigVal[10]; /* Signal values are stored here */

/* Get the ID of the first signal */
sigId[0] = xPCGetSignalIdx(port, "mySubsys/mySignal/si1");

if (sigId[0] == -1) {
/* Handle error appropriately */
}

for (i = 1; i < 10; i++) {
sigId[i] = sigId[0] + 1ij;

xPCGetSignals(port, 10, sigId, sigVal);
/* If no error, sigVal should have the signal values */

VAR AAA AR AR EEELEREEEEEEELEEEEEEEEEEEEEEEEEEEEELEEEEEEELY]

To repeatedly get the signals, repeat the call to xPCGetSignals. If you
do not change sigID, you only need to call xPCGetSignalIdx once.
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xPCGetSignalWidth
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Purpose

Prototype

Arguments

Return

Description

See Also

Return width of signal

int xPCGetSignalWidth(int port, int siglIdx);

port Enter the value returned by either the function
xPCOpenSerialPort or the function xPCOpenTcpIpPort.

sigIdx Enter the index of a signal.

The xPCGetSignalwidth function returns the signal width for a signal
with sigIdx. If there is an error, this function returns -1.

The xPCGetSignalWidth function returns the number of signals for a
specified signal index. Although signals are manipulated as scalars, the
width of the signal might be useful to reassemble the components into a
vector again. A signal’s width is the number of signals in the vector.

API functions xPCGetSignalIdx, xPCGetSignalName, xPCGetSignal,
xPCGetSignals



xPCGetStatelog

Purpose

Prototype

Arguments

Description

Copy state log values to array

void xPCGetStateLog(int port, int first_sample,
int num_samples,
int decimation, int state_id, double *state_data);

port Enter the value returned by either the
function xPCOpenSerialPort or the function
xPCOpenTcpIpPort.

first_sample Enter the index of the first sample to copy.

num_samples Enter the number of samples to copy from the output

log.

decimation Select whether to copy all the sample values or every
Nth value.

state_id Enter a state identification number.

state_data The log is stored in state data, whose allocation is

the responsibility of the caller.

The xPCGetStateLog function gets the state log. It then copies the

log into state_data. You get the data for each state signal in turn by
specifying the state_id. State IDs range from 1 to (N-1), where N is the
return value of xPCGetNumStates. Entering 1 for decimation copies
all values. Entering N copies every Nth value. For first_sample, the
sample indices range from 0 to (N-1), where N is the return value of
xPCNumLogSamples. Use the xPCNumLogSamples function to get the
maximum number of samples.

Note that the target application must be stopped before you get the
number.
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xPCGetStatelog

See Also API functions xPCNumLogWraps, xPCNumLogSamples, xPCMaxLogSamples,
xPCGetNumStates, xPCGetOutputLog, xPCGetTETLog, 